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Introduction

This Handbook explains the basic operations and useful features 
of your CLIÉ™ handheld.

When using your CLIÉ handheld for the first time
The basic features and operations are explained in detail
(pages 9-66).

Sony CLIÉ™ handheld basic operations
Explains the basic operations of your CLIÉ handheld and how to use the 
applications.

Entering data on your Sony CLIÉ™ handheld
Explains how to enter data in your CLIÉ handheld.

Exchanging and updating data using a HotSync® operation
Explains how to use your CLIÉ handheld with your computer.

CLIÉ handheld advanced operations
The convenient features and how to make full use of your CLIÉ 
handheld are explained in detail (pages 67-191).

Customizing your Sony CLIÉ™ handheld (Preferences)
Explains how to customize your CLIÉ handheld in a way that suits you.

Exchanging and updating data using a HotSync® operation 
(Other HotSync® operations)
Explains the methods of HotSync® operations.

Using “Memory Stick™” media
Explains how to use data stored on “Memory Stick” media.

Beaming
Explains how to exchange data with another CLIÉ handheld by beaming.

Using the Bluetooth™ function 
(for Bluetooth™ built-in models only)
Explains how to exchange data with another CLIÉ handheld using the 
Bluetooth™ function.

Using the Calculator and finding records
Explains the calculator and how to find records.

Backing up your Sony CLIÉ™ handheld data
Explains how to back up the data of your CLIÉ handheld.

Protecting your data with a password
Explains how to assign a password to restrict the use of your CLIÉ handheld 
or to protect your data.

Enhancing features with add-on applications
Explains how to install additional applications on your CLIÉ handheld.

Exchanging data with another Sony CLIÉ™ handheld
Explains how to transfer data from your CLIÉ handheld to another CLIÉ 
handheld.
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The following manuals are attached to your CLIÉ handheld.
Refer to the following together with this manual.

Notes
• Some of the illustrations in this manual (Handbook) may not be consistent with your 

Sony CLIÉ handheld.
b For details on your CLIÉ handheld, refer to the “Read This First (Operating 

Instructions).”
• Some of the accessories described in this manual (Handbook) may not be supported 

by your CLIÉ handheld.

Before you start using

When you want to be more familiar with the basic operation of the 
CLIÉ handheld
When you want to change the CLIÉ setting

When you want to be more familiar with how to use the supplied applications
When you want to install the applications you like

When you face problems

READ THIS FIRST (Operating Instructions)

Explains following:
• Setting your CLIÉ handheld and computer
• Basic operation
• What you can do with the applications

Handbook (This manual)

• When using CLIÉ handheld for the first time
The basic features and operations are explained 
in detail.

• CLIÉ handheld advanced operations
The convenient features and how to make full use 
of your CLIÉ handheld are explained in detail.

CLIÉ Application Manual (HTML format: Start 
up on a computer)

The manual explains about how to use the supplied applications in detail.
This manual will be automatically installed in the computer 
when your connect your CLIÉ handheld to the computer.
For details on using the manual, refer to “Using CLIÉ Application 
Manual” in the “Read This First (Operating Instructions).”

Troubleshooting Q&A

The manual helps in solving problems that you may face while using 
your CLIÉ handheld.
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basic operations

This chapter explains the basic operations of your 
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and starting the applications.
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Basic operations

Operating using the stylus and the Jog Dial™ navigator.

Using the stylus

Tip

Where is the stylus located?
The stylus is stored in your CLIÉ handheld. 
The exact storage location varies depending on your model.
b For details, refer to “Sony CLIÉ™ handheld components” of the 

“Read This First (Operating Instructions).”

Note

To prevent losing the stylus, always put it back in its holder on your 
CLIÉ handheld after use.

What is a stylus?
A stylus is a pen for operating your CLIÉ 
handheld by directly touching the screen.

Continued on next page
• • • • • • • • • • • • • • •
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Basic operations

You can operate your CLIÉ handheld using the stylus in the 
following ways. 

Tapping
Lightly pressing the required item on the 
screen with the stylus is called “Tapping.” 
When entering data with the on-screen 
keyboard or starting an application, “tap” 
the desired button or icon with the stylus.

Dragging
Touching the required item on the screen 
with the stylus and moving it along the 
screen surface is called “Dragging.”
Just as you “drag” the mouse on your 
computer, use the stylus to “drag” the 
scroll bar to scroll the screen or “drag” 
characters to highlight them.
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Basic operations

Using the Jog Dial™ navigator

What is the Jog Dial™ 
navigator?
Your CLIÉ handheld is equipped with a 
Jog Dial™ navigator, located at the left 
side of your CLIÉ handheld, which enables 
you to perform major operations one-
handed without the stylus. 

Rotating the Jog Dial™ navigator
Rotate the Jog Dial™ navigator to select 
various items or to start applications.

Continued on next page
• • • • • • • • • • • • • • •
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Basic operations

Note

The operations you can perform by using the Jog Dial™ navigator vary 
depending on the application. 

b For details on the operations of each application, refer to the “CLIÉ 
Application Manual” installed on your computer.

Tip

Rotating while holding down the Jog Dial™ navigator
Some applications support operations executed by pressing and 
rotating the Jog Dial™ navigator. 

Pressing the Jog Dial™ navigator
Press the Jog Dial™ navigator to select an 
item or run a selected application.
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Starting an application

Software that you can use on your CLIÉ handheld to execute a 
task, such as Date Book, To Do List, or e-mail software, is called 
an “application.” You need to start an application to operate your 
CLIÉ handheld.

Note

For details on starting applications on a “Memory Stick” 
media, refer to page 131.
There may be some system limitations when starting applications on a 
“Memory Stick” media in the Application Launcher screen.

Tip

What is the CLIE Launcher screen?
The screen displayed by turning on power and pressing the Home /
Menu  button is called the Application Launcher screen.
The CLIÉ specific screen “CLIE Launcher” is displayed by default.

Starting an application in the Application Launcher 
screen (“CLIE Launcher”)

1 Press the Home /Menu  button to display 
the CLIE Launcher screen.

Note

When you press and hold the Home /Menu  button, the menu 
is displayed.

Continued on next page
• • • • • • • • • • • • • • •
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Starting an application

2 Rotate the Jog Dial™ navigator to select an 
application icon and press the Jog Dial™ 
navigator to start the application.

Tip

You can also tap an application icon in the CLIE Launcher screen to 
start the application.

Quitting an application
You do not need to manually save data in the CLIÉ handheld like 
you do with the computer.
All the changes in the application that you are working on are 
automatically saved, and the last screen you worked on is 
displayed when you restart the application.
Display the CLIE Launcher screen to switch to another 
application while you are working on an application.
You can select one of the two methods to display the CLIE 
Launcher screen as follows.

1 Return to the CLIE Launcher screen by pressing 
the Home /Menu  button.

2 Return to the CLIE Launcher screen by pressing 
and holding the BACK button.

Continued on next page
• • • • • • • • • • • • • • •
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Starting an application

Tips

• You can switch the application to another application by pressing the 
Application button.

• You can return to the CLIE Launcher screen by holding down the 
BACK button.

Note

For some applications, you need to operate Save. 
b For details, refer to the “CLIÉ Application Manual” installed on 

your computer.
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Using “CLIE Launcher”

Locating the components

Tip

Press the Home /Menu  button to display the CLIE Launcher 
screen if it is not displayed.

A CLIE Launcher group list (page 18)
Displays the list of the CLIE Launcher groups.

B Favorite Applications (shortcuts) (page 22)
You can create shortcuts to applications used frequently.

C Application manager icons (page 24)
You can manage your applications. Functions may be added 
when you install certain applications. 

D Application icon list
Displays application names and icons.

Continued on next page
• • • • • • • • • • • • • • •
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Using “CLIE Launcher”

CLIE Launcher group
You can sort applications by grouping them.

Note

Applications on a “Memory Stick” media cannot be grouped.

Editing groups

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Select Edit CLIE Launcher Group from the 
CLIE Launcher menu.
The CLIE Launcher Group setting screen is displayed.

Note

CLIE Launcher groups differ from Palm OS® standard 
screen categories.

Continued on next page
• • • • • • • • • • • • • • •
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Using “CLIE Launcher”

4 Select a group to edit and tap Edit.
The CLIE Launcher Group screen is displayed.

Name: You can rename groups.
Ordering applications listed: Select the application and 
tap Up or Down to order applications in the CLIE 
Launcher screen.
Adding applications: Tap Add to display the list and 
select an application to add.
Removing applications: Select an application to remove 
and tap Remove. Applications removed will be listed in 
the Unfiled group.

Note

The Unfiled group cannot be renamed.

5 Tap Done.
The CLIE Launcher Group setting screen is displayed.

Continued on next page
• • • • • • • • • • • • • • •



Sony CLIÉ™ handheld basic operations 20

Using “CLIE Launcher”

6 Tap Done.
The CLIE Launcher screen is displayed.

Tip

You can add an application to a group by dragging an icon and 
dropping it in the group on the CLIE Launcher screen when the Use 
Drag&Drop check box on the CLIE Launcher Preferences screen 
(page 27) is on. 

Ordering listed groups

1 Select a group on the CLIE Launcher Group 
setting screen.

2 Tap Up or Down.
The order of listed groups in the CLIE Launcher screen is 
changed.

Creating a new group

1 Tap New on the CLIE Launcher Group setting 
screen.

2 Enter a new group name and then tap OK.

Note

Groups that do not include an application are not listed in the main 
screen.
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Using “CLIE Launcher”

Deleting a group

1 Select a group name you want to delete and 
tap Delete on the CLIE Launcher Group 
setting screen.
If the group to be deleted includes an application, the 
Delete CLIE Launcher Group dialog box will be 
displayed. In the dialog box, tap Yes to delete the group. 
The applications included in the deleted group will be listed 
in the Unfiled group.

Note

You cannot delete the Unfiled group.

Selecting a group

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press the BACK button.
You can now perform operations on the CLIE Launcher 
Group List screen with the Jog Dial™ navigator.

3 Rotate the Jog Dial™ navigator to select a group.
The application icon at the top of the list in the group will be 
highlighted.
If you press the Jog Dial™ navigator, the application icon 
list is displayed.

Tips

• The applications saved on the “Memory Stick” media will be 
listed in the  Card group. 

Continued on next page
• • • • • • • • • • • • • • •
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Using “CLIE Launcher”

• You can select the next group by pressing the Home /
Menu  button. You can also tap the F/f icon or group names 
on the screen to select a group.

Using Favorite Applications (shortcuts)
You can create a Favorite Application (shortcut) for frequently 
used applications.

Note

You cannot create a Favorite Application (shortcut) for an application 
on a “Memory Stick” media.

Creating a Favorite Application (shortcut) 

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Select Edit Favorite Applications from the 
CLIE Launcher menu.
The Favorite Application screen is displayed.

Continued on next page
• • • • • • • • • • • • • • •
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Using “CLIE Launcher”

Tip

On the CLIE Launcher screen, you can also tap the empty Favorite 
Application (shortcut) area to display the Favorite 
Application screen.

4 Tap a Favorite Application (shortcut) number 
that you want to assign to an application.
The list of applications is displayed. Tap the application 
name to create a Favorite Application (shortcut).

5 Tap Done.

Note

When you delete an application that is saved as a shortcut, the shortcut 
is automatically deleted from the Favorite Application list.

Tip

You can also create a Favorite Application (shortcut) for an application 
by dragging an icon and dropping it in the empty shortcut area when 
the Use Drag&Drop check box on the CLIE Launcher 
Preferences screen (page 27) is on.

To delete a Favorite Application (shortcut) 
In step 4, tap a Favorite Application (shortcut) number that you 
want to delete and select (None) at the top of the list.

Continued on next page
• • • • • • • • • • • • • • •
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Using “CLIE Launcher”

Tip

You can also delete a Favorite Application (shortcut) for an application 
by dragging an icon and dropping it in  in the top right-hand corner 
of the screen (page 186) when the Use Drag&Drop check box on the 
CLIE Launcher Preferences screen (page 27) is on.

Application manager icon
You can manage your applications with the application manager 
icons.
The following icons are featured as standard functions.

: Transferring applications
Displays Beam dialog box (page 148) or Send dialog 
box (page 153).

: Displaying application information (page 25)
: Deleting applications (page 186)

Tips

• Application manager functions may be added when you install some 
applications.

• You can also manage an application by dragging an icon and 
dropping it in each application manager icon when the Use 
Drag&Drop check box on the CLIE Launcher Preferences 
screen (page 27) is displayed.
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Using “CLIE Launcher”

Displaying information about applications 

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Tap .
The list of applications is displayed.

3 Tap an application name whose information 
you want to display.
The CLIE Launcher Info screen is displayed.
Tap OK to close the screen.

Tip

You can also display information about an application by dragging an 
icon and dropping it in   in the top right-hand of the CLIE Launcher 
screen when the Use Drag&Drop check box on the CLIE Launcher 
Preferences screen (page 27) is displayed.
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Using “CLIE Launcher”

Editing a description
Tap Edit to display the Edit Description screen and enter 
the new description.

OK button: Change to the description entered.
Cancel button: Cancel the description entered.
Default button: Restore the default description.

Menu List
The following list describes the functions of each menu in the 
CLIE Launcher screen.

Menus in the CLIE Launcher screen

Delete… Delete an application (page 186).

Beam… Send an application to another Palm OS PDA 
device via the IR port (page 148).

Send… Bluetooth: Send an application or data to 
another Bluetooth™ compliant 
Palm OS PDA device by 
wireless communication (page 
153).

SMS: Send messages via a connected 
GSM wireless device, such as 
mobile phones.

Note

An application or data cannot be 
send by SMS.

Edit CLIE Launcher 
Group

Edit a group of applications (page 18).

Edit Favorite 
Applications

Create a shortcut to an application (page 22). 
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Using “CLIE Launcher”

Options menu in the CLIE Launcher screen

Info… Display the version, memory size, and the 
number of records of an application.

Copy… Copy an application.

Preferences… Make settings for CLIE Launcher.

Show Expansion Cards
Check the box to display the applications on 
the “Memory Stick” media. 
(Default: On)

Display Animation
Check the box to adjust the on-screen motion 
such as scrolling operation. 
(Default: On)

Use Drag&Drop
Check the box to enable the Drag&Drop 
function. 
(Default: Off)

Use Beam Icon To Beam Only
(available only when there is a 
communication facility other than beaming)
Check the box to display the Beam screen 
automatically when you tap the Beam icon. 
(Default: Off)

Display
Icon (Small): Displays a simple description 
for a selected application.
Icon: Displays a simple description for any 
application. 
(Default: Icon (Small))

Go To Standard 
View

Switch to the Palm OS standard screen 
(page 28).

About 
Applications

Displays version information of the CLIE 
Launcher application.
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Using the Palm OS® standard screen

Switching to the Palm OS® standard screen
Your CLIÉ handheld is initially set to display the CLIE 
Launcher screen when you press the Home /Menu  button. 
To switch to the Palm OS standard screen, follow the procedure 
below.

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Go To Standard View from the Options 
menu.
The screen will be switched to the Palm OS standard screen.

Tip

You can display categories in sequence by pressing the Home /
Menu  button.

Note

Palm OS standard screen categories differ from CLIE Launcher 
groups.

Tap to display 
menus.

Tap to select a 
category to be 
displayed.
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Using the Palm OS® standard screen

Switching to the CLIE Launcher screen

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Go To CLIE Launcher View from the 
Options menu.
The screen is switched to the CLIE Launcher screen.
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Using the Palm OS® standard screen

Starting an application

Note

For details on starting applications on a “Memory Stick” 
media, refer to page 131.
There may be some system limitations when starting applications in 
“Memory Stick” media in the Application Launcher screen.

Starting an application with the Jog Dial™ 
navigator

1 Press the Home /Menu  button to display 
the Palm OS® standard screen.

2 Rotate the Jog Dial™ navigator to select the 
application you want to start, and then press 
the Jog Dial™ navigator.
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Using the Palm OS® standard screen

Changing the preferences of the start-up 
screen for the Jog Dial™ navigator 
operation
Set the preferences so that rotating the Jog Dial™ navigator 
displays a list of applications on the left side of the screen.

1 Press and hold the Home /Menu  button 
on the Palm OS standard screen.
The menu is displayed.

2 Tap Preferences from the Options menu.
The Preferences screen is displayed.

Continued on next page
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Using the Palm OS® standard screen

3 Tap the arrow V next to Jog Select and select 
Popup.

4 Tap OK.
When the Jog Dial™ navigator is rotated, the list of 
applications are automatically displayed on the left of the 
screen.
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Using the Palm OS® standard screen

Starting an application by tapping an 
application icon

1 Press the Home /Menu  button to open the 
Palm OS standard screen.

2 Tap the icon of the application you want to 
start.
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Using the Palm OS® standard screen

Changing the display style of the Palm OS® 
standard screen 

On the Palm OS standard screen, you can display applications in 
the list format or in the small-icon format. You can also choose 
to display your favorite category or last-used application when 
the Palm OS standard screen is displayed.

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Preferences from the Options menu.

4 Tap the arrow V next to the right of View By 
and select List, List (Small) or Icon (Small).

5 Tap OK.

List view List (Small) view Icon (Small) view
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Using the Palm OS® standard screen

Setting to display the last-opened category 
or the last-used application when the Palm 
OS standard screen is displayed

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Preferences from the Options menu.

4 Tap the Remember Last Category check box 
or Remember Last Used App check box to 
select.
The check boxes are marked by the default setting.

5 Tap OK.

Note

Applications are not recognized as the last-used applications and 
categories in the following cases.
• Pressing an application button to start an application or category.
• Switching the screen from the Palm OS standard view to 

the CLIE Launcher view.
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Using the Palm OS® standard screen

Displaying application by category
You can choose to display applications by category.

Categorizing applications

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Category from the Application menu.

4 Tap the arrow V next to each application and 
select the category.

Note

To create a new category, tap the arrow V in the top right-hand 
corner of the Application Launcher screen and then tap Edit 
Categories to open the Edit Categories dialog box.
And tap New, enter a category name, and tap OK. Tap OK 
again when the new category is added.

5 Tap Done.
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Using the Palm OS® standard screen

Displaying category-wise

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Perform either of the following operations.
• Repeatedly press the Home /Menu  button or 

repeatedly press the Jog Dial™ navigator to display the 
categories in sequence.

• Tap the arrow V in the top right-hand corner of the screen 
and select the category you want to display.

Tip

If you select All, all applications are displayed on the Palm OS 
standard screen.
It is useful to select All when you start an application with the Jog 
Dial™ navigator.

Note

CLIE Launcher groups differ from Palm OS® standard 
screen categories.
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Changing fonts

You can change the font style in applications such as Date Book 
or Address Book according to your preferences. A font style can 
be assigned to each application.

1 Start an application whose font style you want 
to change.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Font from the Options menu.
The Select Font dialog box is displayed.

4 Tap the font style you want to use.

5 Tap OK.
The text in the application is displayed in the font style you 
selected.

Note

Font style is not available for some applications.

Continued on next page
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Common menus

The following list describes the function of each menu that is 
common for the CLIÉ handheld applications such as Date Book, 
Address, To Do List, and Memo Pad.
To display the menu, press and hold the Home /Menu  
button while starting the application.
For menus that are specific to an application, refer to the 
descriptions of menus for each application.

Note

Some menus may not be displayed depending on the display style.

Edit Menu

Undo Reverses the action of the last edit command. 
For example, if you used Cut to remove text, 
Undo restores the text you removed. 

Cut Removes the selected text and stores it 
temporarily in the memory of your CLIÉ 
handheld. You can paste the text you cut into 
another area of the current application or into 
other applications.

Copy Copies the selected text and stores it 
temporarily in the memory of your CLIÉ 
handheld. You can paste the text that you 
copied into another area of the current 
application or into other applications.

Paste Inserts the text that you cut or copied at the 
selected point. If you did not previously cut or 
copy text, paste does not work.

Select All Selects all of the text in the current record or 
screen. This function enables you to cut or 
copy all of the text and paste it at the selected 
point.

Continued on next page
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Common menus

Keyboard Opens the on-screen keyboard. 

Graffiti Help Opens the list of Graffiti® character strokes. 
You can view a stroke for a character as 
needed.



Entering data on 
your Sony CLIÉ™ 
handheld

This chapter explains how to enter data on your 
CLIÉ handheld.
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Entering data on your Sony CLIÉ™ 
handheld

You can enter data by following methods other than the 
hardware keyboard.

On-screen keyboard (Input 
panel) (page 43)
Enter data by tapping the keyboard 
displayed on the screen.

Graffiti® (page 46)
Enter data using the freehand input 
characters, called Graffiti. Once 
you get used to entering data using 
Graffiti, it is much faster than 
entering data with the on-screen 
keyboard.
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Practicing entering data using the on-
screen keyboard

You can enter data using the stylus of your CLIÉ handheld.

Entering data
To enter data, you will need software (an application) that is 
compatible with your CLIÉ handheld. Follow the steps below to 
practice entering data using the Date Book application.

1 Tap the Date Book  icon on the Application 
Launcher screen.
Date Book starts up. Today's schedule is displayed.

2 Tap the time line in the Date Book screen.

Continued on next page
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Practicing entering data using the on-screen keyboard

3 Press and hold the Home /Menu  button. 
Tap Keyboard from the Edit menu.
The keyboard is displayed.

4 Select the required keyboard and tap the 
characters to enter text and numbers.
You can use the on-screen keyboard in the same way as in 
the keyboard of your computer. To enter a capital letter, tap 
“cap” and then tap the character button. To delete a 
character, tap  <.

Alphabetic
Tab

Caps lock

Caps shift

Back Space

Carriage return

Tap here to display alphabetic keyboard

Numeric International

Tap here to display the 
numeric keyboard

Tap here to display the 
international keyboard

Continued on next page
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Practicing entering data using the on-screen keyboard

5 When you have finished, tap Done to close the 
on-screen keyboard and place the text in the 
record.
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Using Graffiti® writing to enter data

This section describes the procedures for creating letters, 
numbers, punctuations, and symbols, and teaches you some 
Graffiti® tips and tricks.

What is Graffiti writing?
Most people find they can enter text quickly and accurately with 
only minutes of practice. Graffiti writing includes any character 
you can type on a standard keyboard. The Graffiti strokes closely 
resemble the upper case letters of the regular alphabet, which 
makes Graffiti writing easy to learn.

Entering characters with a single stroke
Most characters require only a single stroke. When you lift the 
stylus from the Graffiti writing area, your CLIÉ handheld 
recognizes and displays the text character immediately. 
To allow you to write an entire character with a single stroke, 
some Graffiti strokes are portions of the regular alphabet 
equivalents.

The dot on each shape shows where to begin the 
stroke
Certain characters have similar shapes, but different beginning 
and end points. Always begin the stroke from the dot.

Note

You do not need to create the dot; it is only there to show you where to 
begin the stroke.

(Graffiti writing examples 
A, B, C, D, E)

Start stroke from dot

Lift stylus here
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Using Graffiti® writing to enter data

The areas for writing letters and numbers are 
different
The Graffiti writing area is divided into two parts: one for 
writing the letters of the alphabet and one for writing numbers.

Tip

To display the Graffiti writing area, select the line to enter characters, 
and then press the Text Input /Find  button. For details, refer to 
“Entering characters with Graffiti” (page 54).

Graffiti character list

Alphabet

A I

B J

C K

D L

E M

F N

G O

H P

Write letters 
here

Write numbers 
here

Continued on next page
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Using Graffiti® writing to enter data

Numbers

Keyboard symbols

Q V

R W

S X

T Y

U Z

0 5

1 6

2 7

3 8

4 9

Space Period Tap twice

Back Space Shift

Carriage 
Return

Caps

Continued on next page
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Using Graffiti® writing to enter data

Writing capital letters
Shift to caps to make capital letters with the same stroke shapes 
as the basic alphabet characters.

• To draw the first letter of a word as a capital letter
Use the Caps Shift stroke  .

To return to lower case, use the BackSpace stroke  .

Note

When you create a new sentence or a new record (by tapping New 
or a blank line), the first letter is automatically capitalized.

• To enter only capital letters (Caps Lock)
Use the Caps Lock stroke  .

To return to lower case, use the Caps Shift stroke  .

Writing punctuation marks
Tap once on the Graffiti writing area to activate Punctuation 
Shift. The next stroke you make anywhere in the Graffiti area 
(the letters or numbers side) creates a punctuation mark.

Caps Shift

Caps Lock

Punctuation Shift

Continued on next page
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Using Graffiti® writing to enter data

To undo punctuation shift
Enter  (Back Space). 

(.) Period (—) Dash

(,) Comma ( ( ) Left 
parenthesis

(’) Apostrophe ( ) ) Right 
parenthesis

(?) Question (/) Slash

(!) Exclamation ($) Dollar

(@) At (\) Back slash

(#) Number ({) Left brace

(%) Percent (}) Right brace

(^) Circumflex ([) Left square 
bracket

(&) Ampersand (]) Right square 
bracket

(*) Asterisk (-) Swung dash

(<) Left angle 
bracket

(\) Grave accent

(>) Right angle 
bracket

(;) Semicolon

(_) Under bar (:) Colon

(" ) Ditto Tab
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Using Graffiti® writing to enter data

Writing symbols and extended characters
Make a Symbol Shift stroke   on the Graffiti writing area to 
activate Symbol Shift. The next stroke you make creates a 
symbol or extended character.

To undo symbol shift mode
Enter  (Back Space).

(•) Bullet x

(™) Trademark ÷

(®) Registered =

(©) Copyrighted (¢) Cent

(‘) Left single 
quotation mark

(¥) Yen

(’) Right single 
quotation mark

(£) Pound

(“) Left double 
quotation mark

( ) Euro

(”) Right double 
quotation mark

¿

(§) Section ¡

(°) Degree ß

+ µ

– ƒ

ø

Symbol Shift



Entering data on your Sony CLIÉ™ handheld 52

Using Graffiti® writing to enter data

Writing accented characters and non- 
English characters
To create accented characters, draw the stroke normally used to 
create the letter, followed by an accent stroke. Graffiti writing 
then adds the accent to the letter.
To enter "é," for example, draw   and then .

To write non-English characters
You can write the following characters without any special 
punctuation or shifting:

Note

You must write these non-English characters on the left side of 
the Graffiti writing area.

à è ì ò ù á é í ó ú ý

â ê î ô û ã õ ñ

ä ï ö ü ÿ å

ç æ
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Using Graffiti® writing to enter data

Displaying the Graffiti on-screen help
Drag the stylus from the writing area to the top of the screen. 
Graffiti Help opens a series of screens that show the complete 
Graffiti character set.
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Using Graffiti® writing to enter data

Entering characters with Graffiti

1 Tap the Date Book  icon on the Application 
Launcher screen.
Date Book starts. Today's schedule is displayed.

2 Tap the time line in the Date Book screen.

3 Press the Text Input /Find  button.
The Graffiti writing area is displayed.

4 Use the tables on the previous pages to find the 
stroke shape for the letter you want to create.
There are two different stroke shapes available for some 
letters. For those letters, choose the one that is easier for you.
You use the same shape to create both the upper case and 
lower case version of a letter.

5 Position the stylus in the left-hand side of the 
Graffiti writing area. Start your stroke at the 
dot and draw the stroke shape as it appears in 
the tables.

Position the stylus

Continued on next page
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Using Graffiti® writing to enter data

6 Lift the stylus from the screen at the end of the 
stroke shape.
When you lift the stylus from the screen, your CLIÉ 
handheld recognizes your stroke immediately and prints the 
letter at the insertion point on the screen.
As soon as you lift the stylus from the screen, you can begin 
the stroke for the next character you want to write.

Note

You must begin the character strokes in the Graffiti writing area. If 
you do not make Graffiti strokes in the Graffiti writing area, your 
CLIÉ handheld does not recognize them as text characters.

Notes on writing Graffiti characters
• Recognition accuracy improves when you write large 

characters. You should draw strokes that nearly fill the Graffiti 
writing area.

• Write at natural speed. Writing too slowly can generate 
recognition errors.

• Do not write on a slant. Vertical strokes should be parallel to 
the sides of the Graffiti writing area.
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Using Graffiti® writing to enter data

Using Navigation strokes and shortcuts
You can navigate within the fields of your application and also 
quickly enter symbols that are frequently used, by entering the 
navigation strokes and shortcuts with Graffiti.

Using navigation strokes

Move cursor right

Move cursor left
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Using Graffiti® writing to enter data

Using Shortcuts
There are four types of Graffiti Shortcut.
To use a Shortcut, draw the Shortcut stroke   followed by the 
Shortcut characters.
When you draw the Shortcut stroke, the Shortcut symbol appears 
at the insertion point to show that you are in Shortcut mode.

The following are the Graffiti Shortcuts that are registered on 
your CLIÉ handheld:

For example, when you enter  “dts” using the Graffiti Shortcut, 
you can enter the current date and time.

Tip

You can also create your own Shortcuts (page 99).

Date stamp ds Breakfast br

Time stamp ts Lunch lu

Date/time stamps dts Dinner di

Meeting me

b b b
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What is a HotSync® operation?

A HotSync® operation is a one-step operation that enables you 
to synchronize data between your CLIÉ handheld and your 
computer. With just one press of the HotSync button, you can 
synchronize your CLIÉ handheld application data with the 
Palm™ Desktop for CLIÉ software data on your computer, back 
up the data of your CLIÉ handheld on your computer, and install 
add-on applications.

1 Synchronizing the data between your CLIÉ 
handheld and your computer
Synchronizes the data of the Date Book, Address Book, 
To Do List, and Memo Pad between your CLIÉ handheld 
and your computer. You can manage the data of multiple 
CLIÉ handhelds separately using the Palm™ Desktop 
for CLIÉ software.

2 Saving backup data on your computer
Automatically creates a backup of the data currently held 
in your CLIÉ handheld to your computer. If you delete 
data by accident, if data is deleted by a sudden battery 
shut-off, or if you need to perform a hard reset, a 
HotSync® operation allows you to restore the data using 
the backup data on your computer.
For details on backing up data, refer to page 168.

Continued on next page
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What is a HotSync® operation?

Tip

You can save a backup of the data currently held in your CLIÉ 
handheld onto a “Memory Stick” media. For details, refer to 
“Backing up data to a “Memory Stick” media using the 
Memory Stick Backup application”  (page 169).

3 Using the data created in Microsoft® Windows® 
applications in your CLIÉ handheld 
Import or export the data between a Windows 
application on your computer and your CLIÉ handheld.

The compatible file formats that you can import/
export with the Palm™ Desktop for CLIÉ software
• Comma/Tab delimited (*.csv, *.txt, *.tab, *.tsv)
• Text file (*.txt)
• vCal (Date Book) file (*.vcs)
• vCard (Address) file (*.vcf)
• Date Book archive of the Palm™ Desktop for CLIÉ software 

(*.dba)
• Address Book archive of the Palm™ Desktop for CLIÉ 

software (*.aba)
• To Do List archive of the Palm™ Desktop for CLIÉ software 

(*.tda)
• Memo Pad archive of the Palm™ Desktop for CLIÉ software 

(*.mpa)

* The words in parentheses are file extensions. Archive is a unit that 
gathers associated files.

b For details on importing/exporting data, refer to the Help menu of 
Palm™ Desktop for CLIÉ software.
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Performing a HotSync® operation

To perform a HotSync® operation, the Palm™ Desktop for 
CLIÉ software must be installed on your computer and the cradle 
should be connected to the computer. 
b For details on how to prepare for a HotSync® operation, follow the 

procedure as described in “Using your CLIÉ™ handheld with your 
computer” in the “Read This First (Operating Instructions).”

Performing a HotSync® operation with the cradle 
(Local HotSync®)

Performing a HotSync® operation with the cradle is called a 
Local HotSync®.

1 Place your CLIÉ handheld in the cradle.

2 Press the HotSync  button on the cradle.
The HotSync® operation starts.

When the HotSync® operation is complete, a message 
showing the HotSync® completion is displayed on your 
CLIÉ handheld.

(Location of the HotSync 

 button may vary 

depending on your 

model.)

Continued on next page
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Performing a HotSync® operation

Note

Do not remove your CLIÉ handheld from the cradle until the 
HotSync® operation is complete as the Palm™ Desktop for CLIÉ 
software may not close normally.

If the HotSync® operation does not start
Make sure that the HotSync   icon is displayed in the 
Windows task tray.
If the HotSync  icon is not displayed in the task tray, click 
Start, Programs (All Programs in Windows® XP), Sony 
Handheld, and HotSync Manager. Check that the 
HotSync  icon is displayed in the task tray and press the 
HotSync  button on the cradle to start the HotSync® 
operation.
The message is displayed on your computer screen when the 
HotSync® operation starts.

* From this point onwards, where Windows XP Home Edition and 
Windows XP Professional are common, they will both be referred to 
as Windows XP.

Tip

If you cannot perform a HotSync® operation
Refer to the “Troubleshooting Q&A.”
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Using the Palm™ Desktop for CLIÉ 
software

The Palm™ Desktop for CLIÉ software enables you to view the 
data, which is transferred from your CLIÉ handheld by the 
HotSync® operation, on your computer. 
Additionally, the Palm™ Desktop for CLIÉ software has the 
same functions as the Date Book, Address Book, To Do List, and 
Memo Pad applications so that you can enter or modify 
schedules or address data on your computer and export data to 
your CLIÉ handheld.

Starting the Palm™ Desktop for CLIÉ software

1 Double-click the Palm™ Desktop for CLIÉ 
software icon on the Windows desktop.
Or click Start, select Programs (All Programs in 
Windows XP), Sony Handheld, and Palm™ Desktop 
for CLIÉ software.
The Palm™ Desktop for CLIÉ software starts.

Tip

To quit the Palm™ Desktop for CLIÉ software
Click the close  button in the top right-hand corner of the screen or 
select Exit from the File menu.
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Using the Palm™ Desktop for CLIÉ software

Locating the Palm™ Desktop for CLIÉ software 
components

A List pane
Displays the records in the current Desktop application.

B Application Launch bar
Click an icon to open the associated application.

C Install Tool icon
Click this icon to display the Install Tool dialog box. You 
can install applications from your CLIÉ handheld with a 
HotSync® operation. For details, refer to “Installing” on 
page 183.

D User selector
Displays the user name of the current information.

Continued on next page
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Using the Palm™ Desktop for CLIÉ software

E Record pane
Displays full details of the record that is selected in the List 
pane. The information displayed here is the same as that 
displayed on your CLIÉ handheld’s Details screen.

Basic operations of the Palm™ Desktop for CLIÉ 
software

Click the icon of the application you want to use. The screen 
switches to the selected application screen.
Basic operations for each application are the same as those of the 
corresponding CLIÉ application. For details on operations, refer 
to the Palm™ Desktop online help. To display the online help, 
select Palm™ Desktop Help from the Help menu.

Tip

Changing the user name of your CLIÉ handheld
1 In the Palm™ Desktop for CLIÉ window, click 

Users from the Tools menu.
The Users dialog box is displayed.

2 Click the user name you want to change and 
click Rename.

3 Enter a new user name and click OK.
Your CLIÉ handheld user name is changed at the next 
HotSync® operation.

Continued on next page
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Using the Palm™ Desktop for CLIÉ software

When using the Microsoft® Windows® XP operating 
system
When you start Palm™ Desktop for CLIÉ software on your 
computer and select Custom, File Link, View Log, or Setup 
from the HotSync menu, the configuration window may open 
behind the Palm™ Desktop for CLIÉ software window.
In this case, bring the configuration window to the front by 
performing one of the following.
– Press the Alt and Tab keys at the same time.
– Click the HotSync   icon in the bottom right-hand corner on 

the Windows task tray.
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What you can do with Preferences

The Preferences screen enables you to customize the configuration options on 
your CLIÉ handheld.
Setting options may be added by installing new application or software for 
peripheral devices.

Tip
For the setting options not mentioned in the list, refer to the “Read This First (Operating 
Instructions).”

Settings Details

Bluetooth Sets the configuration for the Bluetooth™ function.
For details, refer to page 70.
(for Bluetooth™ built-in models only)

Buttons Customizes applications assigned to application buttons 
and a HotSync button, or the full-screen pen stroke 
activities.
For details, refer to pages 73 to 76.

Connection Sets the configuration for the communication device.
For details, refer to page 77.

Date & Time Sets the current date, time, time zone, daylight saving 
configuration.
For details, refer to page 79.

Digitizer Calibrates the screen of your CLIÉ handheld.
For details, refer to page 82.

Formats Sets the formats for time or date.
For details, refer to page 83.

General Sets the general configurations such as system sound, 
LED feature* or auto shut-off interval.
(*not available on certain models)
For details, refer to pages 85 to 88.

Network Sets the Internet connection configuration.
For details, refer to page 89.

Owner Sets the owner information, such as name or phone 
number.
For details, refer to page 173.

ShortCuts Defines a list of Graffiti® abbreviations.
For details, refer to page 99.



Customizing your Sony CLIÉ™ handheld (Preferences) 69

What you can do with Preferences

Displaying the Preferences screen for each menu

1 Rotate the Jog Dial™ navigator to select the Prefs icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Preferences screen is displayed.

Tip
You can also tap the Prefs icon to display the Preferences screen. 

2 Tap the arrow V in the top right-hand corner of the screen 
and select the Preferences menu you want to configure.
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Setting the Bluetooth™ function
(for Bluetooth™ built-in models only)

Note
You cannot use the Bluetooth™ function while the Bluetooth Preferences screen is 
displayed.

Turning the Bluetooth™ function on or off
You can turn the Bluetooth™ function on or off. 

When you disable the Bluetooth™ function, you cannot send data by the 
function but your CLIÉ handheld’s battery is conserved. By default, the 
Bluetooth™ function is disabled.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Bluetooth.
The Bluetooth Preferences screen is displayed.

2 Tap the arrow V next to Bluetooth and select Enabled or 
Disabled.
• Enabled: Turns on the Bluetooth™ function. The Bluetooth LED lights up or 

blinks.
• Disabled: Turns off the Bluetooth™ function.
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Setting the Bluetooth™ function (for Bluetooth™ built-in models only)

Viewing/Customizing Bluetooth™ information
When the Bluetooth™ function is enabled, the following items are displayed 
on the Bluetooth Preferences screen.

Device name You can enter a name for your CLIÉ handheld. The device 
name is required for each CLIÉ handheld to be identified.
You can display the name setup window by tapping the 
square box.

Allow Device to be 
Discovered

Yes: Another Bluetooth™ compatible device detects your 
CLIÉ handheld as a target Bluetooth™ compatible device.
No: Another Bluetooth™ compatible device does not 
detect your CLIÉ handheld as a target Bluetooth™ 
compatible device.
(Default: Yes)

Allow Wake Up Yes: Even when your CLIÉ handheld is turned off, 
another Bluetooth™ compatible device turns on your 
CLIÉ handheld automatically and detects your CLIÉ 
handheld as a target Bluetooth™ compatible device (the 
Bluetooth LED blinks while this feature is enabled).
No: Another Bluetooth™ compatible device does not 
detect your CLIÉ handheld as a target Bluetooth™ 
compatible device when your CLIÉ handheld is turned off.
(Default: No)

Device Address You can display the device address (identification number 
of Bluetooth™ device) of your CLIÉ handheld.
The device address cannot be edited.
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Displaying/Deleting the information of target Bluetooth™ 
compatible devices

You can view information of Bluetooth™ compatible devices registered on 
your CLIÉ handheld or delete unnecessary information.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Bluetooth.
The Bluetooth Preferences screen is displayed.

2 Tap Trusted Devices.
The Bluetooth™ compatible devices registered in your CLIÉ handheld are 
displayed.

3 Select the device whose information you want to display, 
and tap Details….
The Device Details dialog box is displayed.
Tap Done to return to the Trusted Devices screen.

4 To delete the information of the selected device, tap Delete 
Device.
When the confirmation dialog box is displayed, tap OK.

5 Tap Done to return to the Bluetooth Preferences screen.

Adding information of target Bluetooth™ compatible 
devices
Tap Add Device in the Trusted Devices dialog box and follow the on-
screen instructions.
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Assigning applications to application buttons

You can assign your favorite applications to the application buttons on the front 
panel of your CLIÉ handheld.

For example, you can assign the Date Book button to start Calculator.

The position of the application buttons varies depending on your model.
b For details, refer to “Locating the parts of your Sony CLIÉ handheld” in the “Read 

This First (Operating Instructions).”

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Buttons. 
 The Buttons Preferences screen is displayed.

2 Tap the arrow V next to the icon and select the application 
you want to assign. 
The application button is changed to what you assigned.

To start the original applications
If you assigned another application to the button, start the original application 
on the Application Launcher screen.

To reset to default settings
Tap the Default in step 2. 

All application buttons are reset to their factory settings.

The screen may vary depending on your model.
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Customizing the full-screen pen stroke 
activities

You can customize the assignment of the full-screen pen stroke.

(you can perform only when the Graffiti writing area is displayed.)

By default, the full-screen pen stroke activates Graffiti® Help.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Buttons. 

2 Tap Pen.
The Pen screen is displayed.

3 Tap the arrow V next to Graffiti Help and select the settings 
for the full-screen pen stroke.

Tip
Press the Ctrl key and R key on the keyboard at the same time.
You can also display the Graffiti Help screen for the full-screen pen stroke.

Backlight Turns on the backlight of your CLIÉ handheld without 
using the POWER button.

Brightness Opens the Adjust Brightness screen.

Keyboard Opens the on-screen keyboard for entering text.

Graffiti Help Opens a series of screens that show the complete Graffiti 
character set.

Turn Off & Lock Turns off and locks your CLIÉ handheld. To start your 
CLIÉ handheld operation when it is locked, you need to 
enter the password (to use the Lock function, you need to 
enter a password).
b For details, please refer to “Protecting your data with a 

password” (page 172).

Drag the stylus from the writing 
area to the top on the screen.

Continued on next page
• • • • • • • • • • • • • • •
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Customizing the full-screen pen stroke activities

4 Tap OK.

Beam Data Beams the current record to another Palm OS PDA.

Note
Cannot be started by the full-screen pen stroke.
Press the Ctrl key and R key on the keyboard at the same 
time to start beaming.
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Assigning applications to HotSync buttons

You can assign your favorite applications to the HotSync buttons on the cradle 
and modem (if a HotSync button is provided).

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Buttons. 

2 Tap HotSync.

3 Tap the arrow V next to a button and select the application 
you want to assign.

4 Tap OK.
The Buttons Preferences screen is displayed.
You can start the selected application by pressing the HotSync button.
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Adding/Changing communication device 
preferences

You can customize the preference for a communication device to be connected 
to your CLIÉ handheld. The applications using the communication device 
comply with this preference.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Connection.

2 Tap New.
To change the existing preference, tap the preference you want to change 
and Edit.

3 Enter the connection name in Name.
Enter a suitable name.

4 Tap the arrow V next to Connect to and select how you  
connect your CLIÉ handheld to your computer.

5 Tap the arrow V next to Via and select what you use to 
connect your CLIÉ handheld to your computer.

If you select a modem for Connect to

1 Tap the arrow V next to Dialing and select the type of line you want 
to use.
The recommend setting is TouchTone.
Do not select Rotary, except when you are sure that the telephone 
service being used is not TouchTone.

2 Tap the arrow V next to Volume and select the volume of the modem 
speaker at the time of connection.

3 Tap Details.

4 Tap the arrow V next to Speed and select the maximum speed for the 
transmission between the modem and CLIÉ handheld.

5 Tap the arrow V next to Flow Ctl and select the flow control of the 
modem connection. 
The recommend setting is Automatic.

6 Enter the modem initialization command in the Init String.
By default, it is set to either AT&FX4 or ATZ. If the modem 
initialization command is not specified on the modem, it is not required 
to be changed.

7 Tap OK. Continued on next page
• • • • • • • • • • • • • • •
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Adding/Changing communication device preferences

6 Tap OK.
The configuration for the communication device is changed and the 
Preferences screen is displayed.
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Setting the Date & Time preferences

You can set the date, time, time zone, and the on/off of daylight savings for 
your CLIÉ handheld. After you set the local date and time of your home base, 
you can change the displayed time (for example, during business trips) simply 
by switching the time zones.

Setting the date

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap Set Date.
The Set Date screen is displayed.

3 Tap the each arrow b or B beside the year at the top of the 
screen to set the year.

4 Tap the current month.

5 Tap the current date.
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Setting the Date & Time preferences

Setting the time

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap Set Time.
The Set Time screen is displayed.

3 Tap the arrow V or v to set the hour.

4 Tap the minute box and tap the arrow V or v to set the 
minute.

5 Tap AM or PM.

6 Tap OK.
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Setting the Date & Time preferences

Setting the time zone and daylight saving time

Setting the time zone

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap the Set Time Zone field.
The Set Time Zone screen is displayed.

3 Select the time zone of your region.

4 Tap OK.

Setting the daylight saving time

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap the arrow V next to Daylight saving.

3 Tap On or Off.
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Adjusting the Digitizer

You need to adjust the digitizer when performing a hard reset, when the tapping 
operation or scrolling does not work properly, or when you cannot adjust the 
brightness of the back light or screen contrast.

1 Tap the arrow in the top right-hand corner of the 
Preferences screen and select Digitizer.
The Digitizer calibration screen is displayed.

This Digitizer calibration screen is exactly the same as the screen 
displayed the first time you turn on your CLIÉ handheld. Follow the 
on-screen instructions to adjust the digitizer.

Tip
Use the stylus perpendicular to the screen to tap targets.
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Setting the display format of the time, date, 
and numbers

Selecting a regional default
When you select the region where you use your CLIÉ handheld, the display 
format of the time, date, week start day, and numbers are adjusted to the 
regional default. For example, in the United Kingdom, time is expressed using 
a 24-hour clock; in the United States, time is expressed using a 12-hour clock 
with an AM or PM suffix.

The regional default setting is applied to the display formats of all your CLIÉ 
applications. However, you can customize your own settings for each unit, 
such as time or date.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Formats.

2 Tap the arrow V next to Preset to and select a region name.



Customizing your Sony CLIÉ™ handheld (Preferences) 84

Setting the display format of the time, date, and numbers

Customizing your own settings for each unit
You can customize your own settings for the display formats of the time, date, 
week start day, and numbers. The settings are applied to the display formats of 
all your CLIÉ applications. 

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Formats.

2 Tap the arrow V next to Time and select the desired format.

3 Tap the arrow V next to Date and select the desired format.

4 Tap the arrow V next to Week starts and select Sunday or 
Monday.
This setting is applied to the Day, Week, Month, and Agenda views in 
Date Book and all other applications displaying calendars.

5 Tap the arrow V next to Numbers and select the desired 
format.



Customizing your Sony CLIÉ™ handheld (Preferences) 85

Setting the automatic power-off time

Your CLIÉ handheld has an automatic power-off feature that turns off the 
power after a period of inactivity to conserve your CLIÉ battery. 

You can adjust the time setting for the automatic power-off feature.

By default, your CLIÉ handheld will be turned off after two minutes of 
inactivity and will be on while it is connected to the cradle.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to Auto-off After and select the 
desired time.
You can select 30 seconds, 1 minute, 2 minutes, or 3 minutes.

3 If you want to leave your CLIÉ handheld turned on while it is 
connected to the cradle, tap the Stay on in Cradle check 
box.

Note
If you tap the Auto Lock Handheld to lock in the Security screen (page 176), 
the Stay on in Cradle function is cancelled, and the data protection takes the 
priority.
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Setting sounds

You can adjust the volume level of the system sounds, alarm sounds, and game 
sounds or turn the sounds off completely.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to System Sound and select the 
desired volume level or Off.
When the System Sound is turned off, the chime tones associated with the 
HotSync® operation are also turned off.

3 Tap the arrow V next to Alarm Sound and select the desired 
volume level or Off.

4 Tap the arrow V next to Game Sound and select the desired 
volume level or Off.
The Game Sound setting is only applied to the games programmed to 
respond to this setting.
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Turning the Alarm LED on or off

You can set the CLIÉ handheld to flash its LED at the set time. If you turn the 
Alarm Sound off and turn on the Alarm LED, you can use the alarm feature 
without disturbing other people around you.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to Alarm LED and select On or Off.
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Turning the Beam Receive feature on or off

You can turn on or off the Beam Receive feature. 

When you turn off the Beam Receive feature, you cannot receive data via 
beaming but your CLIÉ battery is conserved. By default, the Beam Receive 
feature is set to On.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select General.

2 Tap the arrow V next to Beam Receive and select On or 
Off.
• On: Enables the Beam Receive feature.
• Off: Disables the Beam Receive feature.
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Changing the Network preferences

Note
For the settings specific to each peripheral device, refer to the manual of each peripheral 
device.

Selecting a service template
You can customize the Service setting to select the service template for your 
Internet Service Provider or a dial-in server. 

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Network.
The Network Preferences screen is displayed.

2 Tap the arrow V next to Service and select the service 
template (Internet Service Provider name) you want to 
use.

Tips
• To add the new service template, select New from the Service menu.

If the Internet Service Provider name you want to use is not displayed in the list, 
tap the area showing the service template, or select New from the Service 
menu, and enter the new Internet Service Provider name.
You can create multiple service templates for your Internet Service Provider. 
You need to name them so that those service templates are uniquely identified, 
such as “So-net1” and “So-net2.” It is useful when you use your Internet Service 
Provider by access point or setting.

• If you want to copy an existing service template without changing, select 
Duplicate from the Service menu.
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Changing the Network preferences

Entering a user name
The User Name setting identifies the name you use when you log into your 
Internet Service Provider or dial-in server.

1 On the Network Preferences screen, tap the User Name 
field.

2 Enter your user name.

Notes
• Although this field can contain multiple lines of text, only two lines appear on-

screen.
• Most dial-in servers do not accept spaces in the user name.

Entering a password
The Password box identifies the password you use to log into your server or 
ISP. Your entry in this field determines whether your CLIÉ handheld prompts 
you to enter a password each time you log into your network:

• If you do not enter a password, your CLIÉ handheld displays the word 
-Prompt- in this field and asks you to enter a password during the log-in 
procedure.

• If you enter a password, your CLIÉ handheld displays the word 
-Assigned- in this field and does not prompt you to enter a password during 
the log-in procedure.

Note
If you are concerned about security, select the Prompt option and do not enter a 
password.

1 On the Network Preferences screen, tap the Password 
field.

2 Enter the password you use to log into your server.

3 Tap OK.
The Password field updates to display the word -Assigned-.
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Changing the Network preferences

Selecting a connection
Use the Connection setting to select the method you want to use to connect to 
your Internet Service Provider or a dial-in server.

1 On the Network Preferences screen, tap the arrow V next 
to Connection and select Standard Modem.

Adding telephone settings
When you select the Phone field, your CLIÉ handheld opens a dialog box in 
which you define the telephone number you use to connect with your ISP or 
dial-in server. In addition, you can also define a prefix, disable Call Waiting, 
and give special instructions for using a calling card.

Note

The Phone Setup dialog box works correctly for AT&T and Sprint long- 
distance services. However, because MCI works differently, MCI customers 
need to put the calling card number in the Phone # field and the phone number 
in the Use calling card field.

1 On the Network Preferences screen, tap the Phone field.
The Phone Setup screen is displayed.

2 Enter the phone number for your ISP or dial-in server in the 
Phone # field.

Continued on next page
• • • • • • • • • • • • • • •
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Changing the Network preferences

3 Change the following settings if necessary:

1 Enter the telephone number used to access the modem.
If necessary, enter a dial prefix (such as “9”) to access an outside line, 
and tap the Dial prefix check box. You can enter a comma in the field 
to introduce a “pause” in the dialing sequence. Each comma equals a 
two second pause.

2 If the phone line you are using for your CLIÉ handheld has Call 
Waiting, select the Disable call waiting check box to avoid an 
interruption during a modem HotSync® operation.

Note
Each telephone company assigns a code to disable Call Waiting. Contact your 
local telephone company for the code you need.

3 If you want to use a calling card to place the call, select the Use 
calling card check box and enter the calling card number.

Tip
There is usually a delay before you enter your calling card number.
Consequently, add at least three commas before your calling card number to 
compensate for the delay.

4 Tap OK.

Adding detailed information to a service template
If you are using one of the predefined service templates, you probably only 
need to enter your user name and telephone number. If you are creating a new 
service template, you may need to provide additional information to your ISP 
or dial-in server. Use the Details dialog box to add additional information to 
a selected service template.

To select a connection type

1 On the Network Preferences screen, tap the service field.

2 Tap Details.
The Details screen is displayed.

Continued on next page
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Changing the Network preferences

3 Tap the arrow V next to Connection type and select one of 
the following connection types.
• PPP: Point-to-Point Protocol
• SLIP: Serial Line Internet Protocol
• CSLIP: Compressed Serial Line Internet Protocol

Tip
If you are not sure, try PPP; if that doesn't work, ask your Internet Service Provider 
or your System Administrator for the correct connection type.

4 Tap the arrow V next to Idle timeout and select one of the 
following options.
• 1 Minute: Waits one minute before dropping the connection when you open 

another application that does not use the network.
• 2 Minutes: Waits two minutes.
• 3 Minutes: Waits three minutes.
• Never: Keeps your PPP or SLIP connection open until you turn off your CLIÉ 

handheld (or until it times out).
Note that this option will be more costly than others.

5 Tap the Query DNS check box to deselect it.

6 Enter the IP address for the Primary and Secondary DNS 
(Domain Naming System).
Ask your Internet Service Provider or System Administrator for the 
correct Primary or Secondary DNS IP numbers.

7 If you need to enter the CLIÉ handheld’s IP Address, tap the 
IP Address check box and display a permanent IP address 
field below the check box.
Normally, you do not have to enter this IP address. If you are not sure, 
select Automatic and go to step 9.

8 Enter the CLIÉ handheld’s IP Address.

9 Tap OK.
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Changing the Network preferences

Creating additional service templates
You can create additional service templates from scratch or by duplicating 
existing templates and editing the information. After you create a new or 
duplicate template, you can add and edit settings.

To duplicate an existing service template

1 On the Network Preferences screen, tap the arrow V next 
to Service and select the predefined service template you 
want to duplicate.

2 Press and hold the Home /Menu  button.
The menu screen is displayed.

3 Tap Duplicate from the Service menu.
A copy of the service template (The name of an original service 
template + Copy) is added to the drop-down list for the Service field.

To delete a service template
You can delete an existing service template.

1 On the Network Preferences screen, tap the arrow V next 
to Service and select the predefined service template you 
want to delete.

2 Press and hold the Home /Menu  button.
The menu screen is displayed.

3 Tap Delete from the Service menu.
The Delete Service dialog box is displayed.

4 Tap OK.
The selected service template is deleted.
When you want to cancel deleting, tap Cancel.
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Creating log-in scripts
A log-in script is a series of commands that automates logging in to a network 
server, such as your corporate network or your Internet Service Provider (ISP).

You can also use non-ASCII characters or literal characters for Log-in Scripts.
b For details, refer to “Non-ASCII Characters for Log-in Scripts” on page 97.

1 On the Network Preferences screen, tap the service field.

2 Tap Details.
The Details screen is displayed.

3 Tap Script.
The Log-in Script screen is displayed.

4 Tap the arrow V next to End and select one of the following 
commands.
If the command requires additional information, a field appears to the right 
of it for you to enter the information.

Wait For Tells your CLIÉ handheld to wait for specific characters 
from the TCP/IP server before executing the next 
command.

Wait For Prompt Detects a challenge-response prompt coming from the 
server and displays the dynamically generated challenge 
value. Then enter the challenge value into your token 
card, which in turn generates a response value for you to 
enter on your CLIÉ handheld. This command takes two 
arguments, separated by a vertical bar (|) on the input line.

Send Transmits specific characters to the TCP/IP server to 
which you are connecting.

Send CR Transmits a carriage return or LF character to the TCP/IP 
server to which you are connecting.

Send User ID Transmits the User ID information entered in the User ID 
field of the Network Preferences screen.

Send Password Transmits the password entered in the Password field of 
the Network Preferences screen. If you did not enter 
a password, this command prompts you to enter one. The 
Password command is usually followed by a Send CR 
command.

Continued on next page
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5 Repeat step 4 until the log-in script is complete.

6 Tap OK.
The Details screen is displayed.

7 Tap OK.
The Network Preferences screen is displayed.

Delay Tells your CLIÉ handheld to wait a specific number of 
seconds before executing the next command in the log-in 
script.

Get IP Reads an IP address and uses it as the IP address for your 
CLIÉ handheld. This command is used with SLIP 
connections.

Prompt Opens a dialog box and prompts you to enter text of some 
kind (for example, a password or a security code).

End Identifies the last line in the log-in script.
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Non-ASCII Characters for Log-in Scripts
The following information enables you to create custom log-in scripts that 
require non-ASCII characters. It is provided for advanced users who 
understand the use and requirements of such characters in a custom log-in 
script.

Use of ^char
You may use the caret ( ̂  ) to transmit ASCII command characters. If you send 
^char, and the ASCII value of character is between @ and _, then the character 
is automatically translated to a single-byte value between 0 and 31.

For example, ^M is converted to a carriage return.

If character is a value between A and Z, then the character sequence is 
translated to a single-byte value between 1 and 26. If character is any other 
value, then the character sequence is not subject to any special processing. For 
example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed
You may include carriage return and line feed commands as part of the log-in 
script, when they are entered in the following format.

• <cr> : Sends or receives a carriage return

• <lf> : Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by 
a carriage return and line feed from the remote computer before executing the 
next command in the script.

Literal characters
The backslash ( \ ) character defines that the next character is transmitted as a 
literal character, and is not subject to any special processing ordinarily 
associated with that character.

Examples:

• \^ : Includes a caret as part of the string

• \< : Includes a < as part of the string

• \ \ : Includes a backslash as part of the string
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Changing the Network preferences

Using the Network preferences menus
This section describes the menu commands specific to network preferences. 
For the menu commands that are common for the CLIÉ handheld applications, 
refer to “Common menus” on page 39.

Service menus

Option menus

New Creates a new service template.

Delete... Deletes the current service template.

Duplicate Duplicates the current service template.

View Log Displays the Network Log that lists the history of your 
Internet connection.
Tap Done to close the Network Log screen.
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Creating Graffiti® ShortCuts

You can create abbreviations (ShortCuts) for entering text with Graffiti® 
strokes.

For details on how to use Graffiti® ShortCuts, refer to “Using Shortcuts” on 
page 57.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select ShortCuts.

2 Tap New.
The ShortCut Entry screen is displayed.

3 Enter the ShortCut name and an abbreviation (character 
string).

4 Tap OK.
The new ShortCut is created and the list of ShortCuts is displayed.

To Edit a ShortCut

1 Tap the ShortCut you want to edit and tap Edit.

2 Edit the ShortCut name or the abbreviation (character string) 
and tap OK.

To Delete a ShortCut

1 Tap the ShortCut you want to delete and tap Delete.
 The confirmation message is displayed.

2 Tap Yes.
The selected ShortCut is deleted.
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Customizing HotSync® application settings 
(Conduit)

The programs handling the data of an application during a 
HotSync® operation are called “conduit.”
For each application, you can define a set of options that determine how data 
is handled during synchronization. By default, a HotSync® operation 
synchronizes all data between your CLIÉ handheld and the Palm™ Desktop for 
CLIÉ software.

In addition to the conduits for Date Book, Address Book, To Do List, and 
Memo Pad, the Palm™ Desktop for CLIÉ software offers System and Install 
conduits. The System conduit backs up the system information stored on your 
CLIÉ handheld. The Install conduit installs add-on applications to your CLIÉ 
handheld. You can select them as needed.

1 Click the HotSync  icon in the Windows task tray and 
select Custom from the HotSync® Manager menu.
You can also select Custom from the HotSync menu of the Palm™ 
Desktop for CLIÉ software.
The Custom dialog box is displayed.

2 Select the user name you are using on your CLIÉ handheld 
from the list at the top.

3 Select an application in the Conduit list.

Continued on next page
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4 Click Change.
The Change HotSync Action dialog box is displayed.

5 Click to select one of the following: 
• Synchronize the files

• Desktop overwrites handheld

• Handheld overwrites Desktop

• Do nothing

6 Click OK.

7 Repeat steps 2 to 6 to customize conduit settings for other 
applications (or other users).

8 Click Done.
The conduit setting is changed.

Notes
• The conduit setting is applied only to the next HotSync® operation. Thereafter, the 

HotSync Actions revert to their default settings. To set a new setting as the default, in 
step 5, select the Set as default check box.

• To restore the default settings, click Default in the Custom dialog box.
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Synchronizing with external data (File Link)

You can synchronize Address Book or Memo Pad data in your CLIÉ handheld 
with external files such as address book data in your computer (File Link). 

 HotSync® Manager stores the file data in your computer in a separate category 
on your Palm™ Desktop for CLIÉ software and your CLIÉ handheld. You can 
set the File Link feature to start synchronization only when the external file has 
been updated.

 

 The compatible file formats that you can import with File Link
• Comma delimited (*.csv)

• Memo Pad archive of the Palm™ Desktop for CLIÉ software (*.mpa)

• Address Book archive of the Palm™ Desktop for CLIÉ software (*.aba)

• Text file (*.txt)

b For details on how to set up File Link, refer to the online help of the Palm™ Desktop 
for CLIÉ software.
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Customizing HotSync® Manager startup and 
HotSync® setup options

1 Click the HotSync  icon in the Windows task tray and 
select Setup from the shortcut menu.
The Setup dialog box is displayed.

2 Click the General tab and select the setting as needed.
If you are not sure which option to use, select Always available.
• Always available: Starts the HotSync® Manager when Windows 

starts. This allows you to perform a HotSync® operation even when the 
Palm™ Desktop for CLIÉ software is not running.

• Available only when the Palm™ Desktop is running: Starts the 
HotSync® Manager when you start the Palm™ Desktop for CLIÉ 
software.

• Manual: Starts the HotSync® Manager only when you select 
HotSync® Manager from the Windows Start menu.

3 Click the Local tab and adjust the setting for the connection 
between the computer and cradle as needed.
• Serial port: Specifies the computer port that is used for a HotSync® 

operation. Make sure that the serial port for HotSync® is not shared with 
the port for modem.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems.

4 Click the Modem tab and select the setting for the modem 
as needed.
b For details, refer to “Performing a HotSync® operation via a modem” on page 

112.

5 Click the Network tab and select the setting for the network 
as needed.

6 Click OK to finish.
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Performing an IR HotSync® operation

You can use the IR (infrared) port of your CLIÉ handheld to perform an IR 
HotSync® operation with a computer equipped with an IrDA (Infrared Data 
Association) IR port. An IR HotSync® operation enables you to perform a 
HotSync® operation without using the cradle.

Prior to performing an IR HotSync® operation
Check the following items.

• Your computer is equipped with an infrared port supporting the IrDA 
standard.

• The infrared port of your computer is enabled for use with your Windows 
operating system.

• Check the port number allocated to the infrared port. 

• The infrared port number is available in the Infrared Monitor in the Control 
Panel.
For details on the Infrared Monitor, refer to the manual of your computer or 
the Windows online help.

Preparing your computer
To perform an IR HotSync® operation, you need to allocate a virtual port to an 
IR HotSync® operation.

For Windows 2000 Professional/Windows XP

1 Click the HotSync  icon in the Windows task tray (bottom 
right-hand corner of the taskbar) and select IR.
IR HotSync® operation is enabled.

For Windows 98 Second Edition/Me

1 Click the HotSync  icon in the Windows task tray (bottom 
right-hand corner of the taskbar) and check Local Serial.

Continued on next page
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2 Click the HotSync  icon in the Windows task tray once 
again and select Setup from the shortcut menu.
The Setup dialog box is displayed.

3 Click the Local tab.

4 Adjust the following settings as needed.
• Serial port: Specifies a virtual port for an infrared port. If you are not 

sure of the connection port, refer to the Infrared Monitor in the 
Windows Control Panel.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems.

5 Tap OK.
The IR HotSync® operation is enabled.

Note
When performing a local HotSync® operation with the cradle, you need to restore the 
local HotSync® settings. For details, refer to “To restore the local HotSync settings” on 
page 107.
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Performing an IR HotSync® operation
You can perform an IR HotSync® operation when you have prepared your 
computer settings, CLIÉ handheld settings, and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip

You can also tap the HotSync icon on the Application Launcher screen to 
display the HotSync screen.

2 Tap Local.

3 Tap the arrow V and select IR to a PC/Handheld.

4 Point the IR port of your CLIÉ handheld directly at the IR port 
of the computer.
For best results, your computer and your CLIÉ handheld should be 4 to 8 
inches (approximately 10 to 20 centimeters) apart, and the path between 
your CLIÉ handheld and the computer must be clear of obstacles.

5 Tap the HotSync  icon.
The HotSync® operation starts.
The message will be displayed to note that the HotSync® operation is 
complete.

To restore the local HotSync settings
When performing a local HotSync® operation with the cradle, you need to 
restore the local HotSync settings.

1 Connect the cradle to your computer.

2 Click the HotSync  icon in the Windows task tray and 
check Local USB from the shortcut menu.
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Performing a HotSync® operation using the 
Bluetooth™ function (for Bluetooth™ built-in models only)

If you are using a Bluetooth compatible computer, you can perform a wireless 
HotSync® operation between your CLIÉ handheld and computer.

Prior to performing a HotSync® operation using the 
Bluetooth™ function
To perform a HotSync® operation between your CLIÉ handheld and computer 
using the Bluetooth™ function, you need to configure a new connection setting 
for Bluetooth™ to register your computer as an available connection device.

Preparing your CLIÉ handheld

Note
Prior to performing the following procedure, enable the Bluetooth™ function of your 
computer. For details, refer to the manual of your computer.

1 Tap the arrow V in the top right-hand corner of the 
Preferences screen and select Connection.

2 Tap New….

3 Enter Name.
Enter a unique name for each computer. 
“Custom” is displayed by default.

4 Tap the arrow V next to Connect to and select PC.

5 Tap the arrow V next to Via and select Bluetooth.

6 Tap Tap to discover next to Device.
Your CLIÉ handheld starts to detect Bluetooth compatible devices located 
within a range of the communication area.
When detection is complete, Bluetooth compatible devices around your 
CLIÉ handheld are listed.

Continued on next page
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Tip
If you have renamed a target Bluetooth™ compatible device registered on CLIÉ 
handheld, the device may be listed in the previous name when you detect target 
Bluetooth™ compatible devices.
In this case, follow the procedure below.

1 Press and hold the Home /Menu  button on the Bluetooth 
Preferences screen (page 69).

2 Tap Disable device name cache from the Options menu.

3Detect target Bluetooth™ compatible devices.

7 Select a computer you want to register and tap OK.
The Add Trusted Device dialog box is displayed.

8 Tap Yes.
The Bluetooth Security dialog box is displayed on your CLIÉ 
handheld.

9 Enter a passkey and tap OK on your CLIÉ handheld.
The Passkey Input dialog box is displayed on the screen of the selected 
computer.

Tip

What is a passkey?
A passkey is a secret code entered by a user to enable two Bluetooth compatible 
devices to communicate. A user can enter any characters and numbers to create a 
passkey.
The same passkey should be entered on both devices to permit communication 
between those devices. A user can change a passkey for every communication 
session as long as the same one is used for both devices. Once communication is 
permitted, the communication between the devices will be available without 
entering the passkey for a preset period of time.

10 Enter the same passkey you entered in step 9 on your 
computer.
If the name you entered in step 3 is added to the Available 
Connections: list, the preparation is complete.

Continued on next page
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Tips
• Depending on Bluetooth compatible devices, the procedure to display the Passkey 

Input dialog box may be different from the above instructions or the Passkey input 
dialog box may not be displayed. In this case, follow the on-screen instructions and 
enter a passkey as needed.

• Depending on the radio wave conditions, it may take time to complete detection or 
establish a communication.

• If it takes too much time to detect the Bluetooth compatible computer, tap Cancel and 
try again.

• If the Bluetooth compatible computer cannot be detected, try again.

Performing a HotSync® operation using the Bluetooth™ 
function

1 Enable the Bluetooth™ function on your computer.

2 Check that the HotSync  icon is displayed in the 
Windows task tray (bottom right-hand corner of the taskbar) 
on your computer.

Tip
If the HotSync  icon is not displayed in the Windows task tray, from the Start 
menu, click Programs (All Programs in Windows XP), Sony CLIE, and 
HotSync Manager to start the HotSync manager.

3 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

4 Check that Local is selected.

Continued on next page
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5 Tap the arrow V below the icon and select the connection 
you want to use.
Select the connection name you created in step 3 in “Preparing your CLIÉ 
handheld” on page 108.

6 Tap the HotSync  icon.
A HotSync® operation starts.
A message will be displayed to note that the HotSync® operation is 
complete.

Tip
The Bluetooth™ communication between your CLIÉ handheld and computer will 
be disconnected automatically when the HotSync® operation is complete.
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Performing a HotSync® operation via a modem

You can perform a HotSync® operation via a modem when you are away from 
your computer.

Prior to performing a HotSync® operation via a modem
Check the following items.

• A modem or terminal adapter (TA) is connected to your computer.

• The Palm™ Desktop for CLIÉ software is properly configured for use with 
the modem.

b For details, refer to “Customizing HotSync® Manager startup and 
HotSync® setup options” on page 104.

Notes
• For the first HotSync® operation, you need to perform a local HotSync® operation 

using the cradle (page 61). 
• It may take some time to complete a HotSync® operation via a modem. To shorten 

the time required to synchronize data with a modem, define the files and/or 
applications you synchronize with a modem HotSync® operation in advance. For 
details, refer to “Selecting the conduits for a modem HotSync® operation” on page 
116.

Your CLIÉ handheld 
away from your PC

A HotSync® operation 
with the PC at home
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Preparing your computer
To perform a HotSync® operation via a modem, you need to follow the steps 
below to set your computer to receive a call from your CLIÉ handheld.

1 Check the following items.
• The modem is connected to your computer and both the modem and 

computer are turned on.

• No communication applications, such as fax or telephone software, are 
running on the COM port.

• The computer is disconnected from the Internet.

2 Click the HotSync  icon in the Windows task tray (bottom 
right-hand corner of the taskbar) and select Modem from the 
shortcut menu.

3 Click the HotSync  icon in the Windows task tray again 
and select Setup from the shortcut menu.
The Setup dialog box is displayed.

4 Click the Modem tab.

Continued on next page
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5 Adjust the following settings as needed.
• Serial port: Specifies the port for the modem. If you are not sure of the 

port settings, check the Modem Properties (Phone and Modem 
Options for Windows 2000 Professional/XP) in the Windows 
Control Panel.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems.

• Modem: Specifies the modem type or manufacturer. If you are not sure 
of your modem type or if you cannot find your modem type in the list, 
select Hayes Basic.

• Setup string: Identifies the setup string for your modem automatically 
if you specify the modem type or manufacturer. If it does not work 
properly, refer to the manual of your modem.

6 Click OK.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for a modem HotSync® 
operation.

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon on the Application Launcher screen to display 
the HotSync screen.

2 Tap Modem.

Continued on next page
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3 Tap the Enter phone # field beneath the modem name.
The Phone Setup dialog box is displayed.

4 Adjust the following settings if necessary:
1 Enter the telephone number used to access the modem connected to 

your computer.

2 Enter a dial prefix (such as “9”) to access an outside line, and tap the 
Dial prefix check box as needed. You can also enter a comma in the 
field to introduce a pause in the dialing sequence. Each comma equals 
a two second pause.

3 If the phone line you are using for your CLIÉ handheld has Call 
Waiting, select the Disable call waiting check box to avoid an 
interruption during the modem HotSync® operation.

4 If you want to use a calling card to place the call, select the Use 
calling card check box and enter the calling card number.

5 Tap OK.
The HotSync screen is displayed again.
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Selecting the conduits for a modem HotSync® operation
You can specify files and/or applications to be synchronized to shorten the time 
required to synchronize data with a modem.

b For details, refer to “Customizing HotSync® application settings (Conduit)” 
on page 101.

Note
If your CLIÉ handheld settings do not match those made in the Change HotSync Action 
window, the operation complies with the CLIÉ handheld's configurations.

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip

You can also tap the HotSync icon to display the HotSync screen.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap Conduit Setup from the Options menu.
The Conduit Setup screen is displayed.

Continued on next page
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4 Tap the check boxes to deselect the files and applications 
that you do not want to synchronize during a modem 
HotSync® operation.
By the default setting, all files are selected to be synchronized.
The data of applications that do not have a database (such as games) 
cannot be synchronized.

5 Tap OK.

Performing a HotSync® operation via a modem
You can perform a modem HotSync® operation when you have prepared your 
computer settings, CLIÉ handheld settings, and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator.
The HotSync screen is displayed.

Tip

You can also tap the HotSync icon to display the HotSync screen.

2 Tap the HotSync  icon.
A HotSync® operation starts.
A message will be displayed to note that the HotSync® operation is 
complete.
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Performing a HotSync® operation via a 
network

You can perform a HotSync® operation via a network between your CLIÉ 
handheld and the computer in the LAN of your office depending on the 
network environment of your office. For details, contact the administrator of 
the remote access server.

Prior to performing a HotSync® operation via a network
Check the following items.

• Both your company’s network system and its remote access server support 
TCP/IP.

• You have a remote access account.

Preparing your computer

1 Click the HotSync  icon in the Windows task tray (bottom 
right-hand corner of the taskbar) and select Network from 
the shortcut menu.

2 Click the HotSync  icon in the Windows task tray again 
and select Setup from the shortcut menu.
The Setup screen is displayed.

3 Click the Network tab.

4 Click the check box next to the user name for HotSync.
Click TCP/IP Settings and assign a subnet mask as needed. For details 
on a subnet mask address, refer to the manual of your operating system or 
contact the system administrator.

5 Click OK.

To operate HotSync® operations via a network, you must have network 
administrator skills.

Continued on next page
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6 Place your CLIÉ handheld on the cradle and press the  
HotSync  button.
The computer information (Primary PC name and Primary PC address (IP 
address)) is transferred to your CLIÉ handheld. 
When you perform a HotSync® operation via a network, your CLIÉ 
handheld identifies the computer based on the information transferred.
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Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for a HotSync® operation 
via a network.

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen. 
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap Modem.

3 Press and hold the Home /Menu  button.
The menu is displayed.

4 Tap Modem Sync Prefs from the Options menu.
The Modem Sync Preferences screen is displayed.

5 Tap Network.

6 Tap OK.
The HotSync screen is displayed.

Continued on next page
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7 Tap Select Service beneath the icon.
The Network Preferences screen is displayed.

8 Tap the arrow V next to Service and select Unix or Windows 
RAS from the drop-down list.
For details, refer to “Changing the Network preferences” on page 89 and 
contact the administrator of the remote access server.

9 Tap Done.

10 Tap the Enter phone # field.
The Phone Setup dialog box is displayed.

11 Adjust the following settings as needed.

12 Tap OK. 
The HotSync screen is displayed.

13 Follow “Performing a HotSync® operation via a modem” on 
page 112 to select data to be synchronized.
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Performing a HotSync® operation via a network
You can perform a HotSync® operation via a network when you have prepared 
your computer setting, CLIÉ handheld setting, and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen.
The HotSync screen is displayed.

Tip

You can also tap the HotSync icon to display the HotSync screen.

2 Tap the HotSync  icon.
A HotSync® operation starts.
The message will be displayed to note that the HotSync® operation is 
complete.



123Exchanging and updating data using a HotSync® operation 
(Other HotSync® operations)

Performing a HotSync® operation via LAN 
(LANSync)

You can perform a HotSync® operation via LAN between your computer and 
another computer connected to your CLIÉ handheld.

Prior to performing a LANSync operation
Check the following items.

• The Palm™ Desktop for CLIÉ software is installed in both computers 
connected by the LAN.

• Your CLIÉ handheld is placed on the cradle connected to the HotSync cable 
correctly and the cradle is connected to the computer properly.

Preparing your computer

1 Click the HotSync  icon in the Windows task tray (bottom 
right-hand corner of the taskbar) and select Network from 
the shortcut menu.

2 Click the HotSync  icon in the Windows task tray again 
and select Setup from the shortcut menu.
The Setup screen is displayed.

3 Click the Network tab.

4 Click the check box next to the user name for HotSync.

5 Click OK.

To operate LANSync, you must have network manager skills. Consult a 
network manager prior to setting LANSync.

LANSync via LAN

LAN

Your computer

Continued on next page
• • • • • • • • • • • • • • •



124

Performing a HotSync® operation via LAN (LANSync)

Exchanging and updating data using a HotSync® operation 
(Other HotSync® operations)

6 Place your CLIÉ handheld in the cradle and press the 

HotSync  button.

The computer information (Primary PC name and Primary PC address (IP 
address)) is transferred to your CLIÉ handheld. 
When you perform a HotSync® operation via LAN, your CLIÉ handheld 
identifies the computer based on the information transferred.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for a HotSync® operation 
via the LAN.

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen. 
The HotSync screen is displayed.

Tip

You can also tap the HotSync icon to display the HotSync screen.

2 Tap Local.

3 Press and hold the Home /Menu  button.
The menu is displayed.

4 Tap LANSync Prefs in the Options menu.
The LANSync Preferences screen is displayed.

5 Tap LANSync.
Continued on next page
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6 Tap OK.
The HotSync screen is displayed.

Performing a LANSync operation
You can perform a LANSync operation when you have prepared your 
computer setting, CLIÉ handheld setting, and Conduit Setup. Turn on the 
computers and start the HotSync® Manager application.

Note
To perform a LANSync operation, both computers connected to the cradle and 
performing a HotSync® are required to be set for LANSync. On each computer, click the 
HotSync  icon in the Windows task tray (bottom right-hand corner of the taskbar) 
and make sure that Network in the shortcut menu is selected. If not, click Network to 
check it.

1 Rotate the Jog Dial™ navigator to select the HotSync icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen.
The HotSync screen is displayed.

Tip
You can also tap the HotSync icon to display the HotSync screen.

2 Tap the HotSync  icon.
A HotSync® operation starts. 
The message will be displayed to note that the HotSync® operation is 
complete.
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What is “Memory Stick” media?
“Memory Stick” media is a compact, portable and versatile Integrated Circuit 
recording medium with a data capacity that exceeds a floppy disk. “Memory 
Stick” media is specially designed for exchanging and sharing data among 
“Memory Stick” media compatible products. Because it is removable, 
“Memory Stick” media can also be used for external data storage.

“Memory Stick” media enables you to exchange data between your CLIÉ 
handheld and computer. To exchange data via “Memory Stick” media, your 
CLIÉ handheld uses the supplied CLIE Files application.

There are two types of “Memory Stick” media:

• “MagicGate Memory Stick” media, which is equipped with “MagicGate*” 
copyright protection technology.

• “Memory Stick” media, which is not equipped with “MagicGate” copyright 
protection technology.

You can use both types of “Memory Stick” media with your CLIÉ handheld. 
However, to play music files of ATRAC3 format, make sure to use 
“MagicGate Memory Stick” media.

*What is MagicGate?
MagicGate is the copyright protection technology that is used for “MagicGate Memory 
Stick” media or MagicGate compatible devices such as a CLIÉ handheld. MagicGate 
certifies the compatible device and “MagicGate Memory Stick” media as copyright-
protection-compatible devices and encodes data to be played back on devices. The 
copyrighted data cannot be played back on a device not certificated.

“Memory Stick Duo” and “MagicGate Memory Stick Duo” can be also used 
with your CLIÉ handheld.

“Memory Stick PRO**” can be used, but upgrading is required.
**However, you cannot record or play back the copyright protected files using 

MagicGate.

For details, refer to our official Sony CLIÉ website on the back cover.

Note on using “MagicGate Memory Stick” media
Do not handle copyright-protected files or directories stored on “MagicGate 
Memory Stick” media with the CLIE Files application or Windows® Explorer, 
the file may be disabled. To handle copyright-protected files, use a 
“MagicGate” compliant application such as the SonicStage software.

Continued on next page
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Notes
If you use a “Memory Stick Duo” with your CLIÉ handheld
b Make sure you use a “Memory Stick Duo” adapter when using a “Memory Stick Duo” 

with your CLIÉ handheld.
b Make sure you insert a “Memory Stick Duo” into the “Memory Stick Duo” adapter in 

the right direction.
b Do not insert a “Memory Stick Duo” adapter into the “Memory Stick” slot of your 

CLIÉ handheld when a “Memory Stick Duo” is not inserted into the adapter.
b Make sure you insert a “Memory Stick Duo” adapter into the “Memory Stick” slot of 

your CLIÉ handheld in the right direction.

Inserting and removing a “Memory Stick” media
Insert a “Memory Stick” media into the “Memory Stick” slot.

While the power of your CLIÉ handheld is on, the applications in the “Memory 
Stick” media will be displayed on the Application Launcher screen 
automatically if you insert the “Memory Stick” media into the slot (the feature 
does not work when certain application is running).

Notes
• Insert a “Memory Stick” media in the right direction. If it is forced in the wrong 

direction, it may be damaged.
• Do not insert a “Memory Stick” media into the place other than the “Memory Stick” 

slot.

The “Memory Stick” LED blinks 
in orange while your CLIÉ 
handheld is accessing “Memory 
Stick” media

(Location of the “Memory 
Stick” slot or “Memory Stick” 
LED may vary depending on 
your model.)

Continued on next page
• • • • • • • • • • • • • • •



Using “Memory Stick™” media 129

Using “Memory Stick™” media

To remove “Memory Stick” media
Make sure that your CLIÉ handheld is not writing to or reading data from 
“Memory Stick” media. Push the “Memory Stick” media gently into the slot to 
release it. When the “Memory Stick” media has popped out, pick it out from 
the slot.

Notes on using “Memory Stick” media
When you use “Memory Stick” media, follow the precautions below.

• Avoid touching the terminals of “Memory Stick” media with your fingers or 
a metal object.

• Do not drop, bend, or expose “Memory Stick” media to external shock.

• Do not disassemble or modify “Memory Stick” media.

• Avoid getting liquid on “Memory Stick” media.

• Avoid using or storing “Memory Stick” media in a location subject to:

– extremely high temperature such as inside of a hot car, the outdoors 
exposed to direct sunlight, or near a heater

– direct sunlight  – high humidity

– corrosive substances – excessive dust

– magnetic fields

• When storing and carrying “Memory Stick” media, keep it in its original case 
to ensure protection of important data.

• Make a backup of important data.

• Avoid removing “Memory Stick” media from the insertion slot while data is 
being written or read.

• To avoid damaging or erasing data, do not

– pull out “Memory Stick” media or unplug the AC power adapter while 
formatting, or reading or writing data.

– use “Memory Stick” media in a location subject to static electricity or 
electrical interference.

Push “Memory Stick” media in Pull “Memory Stick” media out

b

Continued on next page
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• If the battery of your CLIÉ handheld is running short, an error message is 
displayed and you cannot exchange data with “Memory Stick” media. If this 
occurs, connect the AC power adapter or fully charge your CLIÉ handheld.

• Use the CLIE Files application to format the “Memory Stick” media you use 
in your CLIÉ handheld. If you format it using another application, further 
operation with your CLIÉ handheld is not guaranteed.

• If you insert “Memory Stick” media that has been formatted by another 
application, a message prompting you to format it is displayed. To use 
“Memory Stick” media in your CLIÉ handheld, follow the instructions to 
format it. Note, however, that all stored data will be erased.

• Make sure to stick a dedicated label on the “Memory Stick” media.

Protecting the data on “Memory Stick” media
To prevent accidental erasure of important data, you can use the write protect 
tab of “Memory Stick” media. 

Write enable position
Slide the tab to the left to select the write enable position. You can read and 
write data on the “Memory Stick” media.

Write protect position (LOCK)
Slide the tab to the right to select the write protect position. You can only read 
the data in the “Memory Stick” media. Select the write protect position when 
you insert “Memory Stick” media containing any important data that you do 
not want to accidentally delete or overwrite.

Tip
Shape or exact location of the tab may differ from the illustration.

LOCK

Back side

Write Enable 
Position

Write Protect 
Position
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Starting an application on “Memory Stick” media
You can start the applications in “Memory Stick” media in the same way as the 
applications of your CLIÉ handheld. While the power of your CLIÉ handheld is on, the 
applications in the “Memory Stick” media will be displayed on the Application Launcher 
screen automatically if you insert the “Memory Stick” media into the slot (the feature 
does not work when certain application is running).
To switch from the Application Launcher screen to the screen where the applications in 
“Memory Stick” media are displayed, perform the following steps.

Tip
You cannot start applications other than those saved in the /PALM/Launcher folder by 
performing the following steps. 

1 Display the Application Launcher screen, while the “Memory 
Stick” media is inserted in the CLIÉ handheld.

2 Press the BACK button to select the group.

3 Rotate the Jog Dial™ navigator to select  Card.
The applications on “Memory Stick” media are displayed.
You can start an application in the same way that you start an application 
of your CLIÉ handheld.
If you have assigned a name to the “Memory Stick” media, then the  
Card is displayed in that name.

Tip
You can also tap the  Card icon to select it.

Continued on next page
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Note
Depending on the application, some of the features may not work if you start the 
application on “Memory Stick” media. In this case, use the CLIE Files application to 
copy the data in the CLIÉ handheld and use the copied data.

Viewing information of a “Memory Stick” media (Card Info)
You can view the information (such as the remaining memory space) of the 
“Memory Stick” media with the Card Info application. 

1 Insert the “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select the Card Info icon 
and press the Jog Dial™ navigator.
The Card Info screen is displayed.

Tip
You can also tap the Card Info icon to display the Card Info screen.
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Assigning a name to a “Memory Stick” media
You can assign a name to each “Memory Stick” media with the Card Info 
application.

1 Insert the “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select the Card Info icon 
and press the Jog Dial™ navigator.
The Card Info screen is displayed.

3 Press and hold the Home /Menu  button.
The menu is displayed.

4 Tap Rename Card in the Card menu.
The Rename Card dialog box is displayed.

5 Enter a new name for the inserted “Memory Stick” media and 
tap Rename.
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Formatting “Memory Stick” media
A “Memory Stick” media produced commercially is already formatted for use. 
If you need to format your “Memory Stick” media, use the CLIE Files or Card 
Info application. The following explains how to format a “Memory Stick” 
media with the CLIE Files application.

1 Insert the “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select CLIE Files and 
press the Jog Dial™ navigator. 
The CLIE Files application starts.
You can also tap the CLIE Files icon to start the application.

3 Press and hold the Home /Menu  button.
The menu is displayed.

4 Tap Format from the Tool menu.
The confirmation message is displayed.

5 Enter a new name for the formatted “Memory Stick” media 
and tap OK.
The Confirmation message is displayed.

6 Tap OK.

To cancel formatting
Tap Cancel in step 5.

What is formatting?
Formatting defines the recording format for your “Memory Stick” media so 
that you can access data with your CLIÉ handheld.

Continued on next page
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Notes
• If a “Memory Stick” media is reformatted, all the data stored in the “Memory Stick” 

media will be erased. Make sure you check the data prior to formatting so that you do 
not delete important data.

• To use the “Memory Stick” media on your CLIÉ handheld, format it in your CLIÉ 
handheld. “Memory Stick” media formatted by the computer may not be read or 
written properly on your CLIÉ handheld.

• If you remove the “Memory Stick” media during formatting, the “Memory Stick” 
media will not be recognized. In this case, insert the “Memory Stick” media again to 
restart formatting.
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Starting CLIE Files
You can copy, move, or delete data between a “Memory Stick” media and your 
CLIÉ handheld with the CLIE Files application.
b For details on the CLIE Files application, refer to “CLIE Files” in the “CLIÉ 

Application Manual” installed on your computer.

1 Rotate the Jog Dial™ navigator to select CLIE Files and 
press the Jog Dial™ navigator.
The CLIE Files application starts and the list of data in the “Memory 
Stick” media is displayed.
You can also tap the CLIE Files icon to start the application.

When displaying the data on a “Memory Stick” media
The following icons are displayed only when you view the data on “Memory 
Stick” media. For the other icons, refer to “When displaying the data on your 
CLIÉ handheld” on page 137.

*  and  icons are specific to the screen when displaying the data on a “Memory 
Stick” media. Except for these icons, all icons in the screen are common to the one 
when displaying the data on your CLIÉ handheld. You can also rotate the Jog Dial™ 
navigator to select a folder.

Tap here to switch the view of the following
• size: File size
• creator: Creator ID of the file
• type: File type
• version: Version of the file
• none: no items displayed

Tap here to display the upper directory*

Tap here to display the contents of the folder*

Tap here to sort in ascending 
or descending order

Tap here to switch the view 
between your CLIÉ handheld 
and “Memory Stick” media

Tap here to switch the view of the following
• Name: name displayed on the computer
• DBname: name assigned on your CLIÉ 

handheld

Tap here to switch to the Directory list screen

Tap here to switch the view between your 
CLIÉ handheld and “Memory Stick” media

Continued on next page
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Tip
You can select a folder in the Directory list screen and tap OK to display the contents 
of the folder. Additionally, you can tap New to create a new folder or tap Rename to 
change the name of existing folder.

Notes
• When the directory tree is made up of nine levels or more, directory levels are not 

displayed. 
• When the battery power of your CLIÉ handheld is insufficient, data on “Memory 

Stick” media may not be displayed. In this case, you need to charge your CLIÉ 
handheld or connect the AC adapter to your CLIÉ handheld.

When displaying the data on your CLIÉ handheld

Notes on moving or deleting data using the CLIE Files 
application
In some cases when you move or delete a specific file using the CLIE Files 
application, some CLIÉ applications may not be operated properly or some 
data may be formatted. Sony is not liable for any trouble with applications or 
data that arises out of your moving or deleting a file.

Do not move or delete the following files:

• Saved Preference: Saves the final operation status or settings for various 
applications.

• Unsaved Preference: Saves the settings for various applications or user 
information of your CLIÉ handheld. If this file is deleted, you may not be 
able to synchronize the correct information.

Switch the database display by group
• All databases
• Creator group
• Application

Lock  icon

Continued on next page
• • • • • • • • • • • • • • •



Using “Memory Stick™” media 138

Exchanging data via “Memory Stick” media

• CLIE Launcher XXX: Saves the database for CLIE Launcher. If this file is 
deleted, you may not be able to operate CLIE Launcher.

• NetworkDB: Saves network settings. If this file is deleted, network 
connection is disabled.

• AddressDB: Saves the database for Address Book*.

• DatebookDB: Saves the database for Date Book*.

• MemoDB: Saves the database for Memo Pad*.

• ToDoDB: Saves the database for To Do List*.
* These database files can be copied to “Memory Stick” media as a backup file. If you 

copy them back to your CLIÉ handheld, the identical files in your CLIÉ handheld will 
be overwritten with the information at the time of the backup. Note that any added or 
edited information in your CLIÉ handheld after the backup will not be restored.

Copying your CLIÉ handheld data to a “Memory Stick” media
You can save your CLIÉ handheld data to “Memory Stick” media with the 
CLIE Files application.

Notes
• Since copying data consumes a lot of power, you cannot use “Memory Stick” media 

when your CLIÉ handheld is short of battery power. In this case, connect the AC 
adapter to your CLIÉ handheld.

• If your CLIÉ handheld receives IR communication while copying data, the copying 
will be interrupted. Do not allow your CLIÉ handheld to receive IR communication 
while copying data.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

Continued on next page
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3 Rotate the Jog Dial™ navigator to select CLIE Files and 
press the Jog Dial™ navigator.
The CLIE Files application starts and the list of data on the “Memory 
Stick” media is displayed.

Tip
You can also tap the CLIE Files icon to start the application.

4 Press the Jog Dial™ navigator to select Internal in the top 
right-hand corner of the screen.

5 Tap the data you want to copy and change  to . 
You can select multiple items by selecting the check boxes.

Note
Data marked with the   icon cannot be copied.

6 Tap Copy.
The Directory list screen is displayed.

7 Tap the “Memory Stick” directory.
When you want to create a new directory on the “Memory Stick” media, 
tap New and enter the directory name. Tap the directory created.
When you want to rename an existing directory, tap Rename and enter 
the new name.

8 Tap OK.
The data is copied to the directory selected in step 7.

Continued on next page
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To copy all the data at once
Tap Select in step 5 and select Select all.

To cancel the selection
• To cancel all the selections: tap Select and select Clear all.
• To clear only specific items: tap the selected item once again.

When you want to select data other than the one specified
After following step 5, tap Select and select Invert. The selections of  and 

 are reversed.

Moving your CLIÉ handheld data to “Memory Stick” 
media
When the memory space of your CLIÉ handheld is not sufficient, you can 
move the data from your CLIÉ handheld to a “Memory Stick” media.

1 In step 6, tap Move.
The data on your CLIÉ handheld is transferred to the “Memory Stick” 
media and saved.

Note
If the low battery error message is displayed while you are copying or moving data from 
your CLIÉ handheld to a “Memory Stick” media, invalid files created by incomplete 
copying or moving may be left in the “Memory Stick” media. 
Charge your CLIÉ handheld and try copying or moving again. If the overwrite confirm 
message is displayed, tap Yes or Yes to all.
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Copying data on “Memory Stick” media to your CLIÉ handheld
You can copy the data saved on a “Memory Stick” media to your CLIÉ 
handheld. Prior to copying data, make sure that the memory space of your 
CLIÉ handheld is sufficient.

Tip

You can also copy data to another folder on the “Memory Stick” media.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

3 Rotate the Jog Dial™ navigator to select CLIE Files and 
press the Jog Dial™ navigator.
The CLIE Files application starts and the list of data in the “Memory 
Stick” media is displayed.

Tip
You can also tap the CLIE Files icon to start the application.

4 Tap the data you want to copy and change  to .
You can select multiple items by selecting the check boxes.

5 Tap Copy.
The Directory list screen is displayed.

6 Select Internal.
Continued on next page
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7 Tap OK.
The data selected in step 4 is copied to Internal.

To copy all the data at once
Tap Select in step 4 and select Select all.

To cancel the selection
• To cancel all the selections: tap Select and select Clear all.
• To clear only specific items: tap the selected item once again.

To change the folder to be copied
Tap  or  to select the folder you want to copy. The displays of the folders 
are changed. You can specify a folder to be copied.

Moving data on “Memory Stick” media to your CLIÉ 
handheld
You can move the data from a “Memory Stick” media to your CLIÉ handheld.

1 In step 5, tap Move.
The data on the “Memory Stick” media is transferred to your CLIÉ 
handheld and saved.

Note
Some data copied from “Memory Stick” media to your CLIÉ handheld may not be 
synchronized during a HotSync® operation.
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Deleting data on “Memory Stick” media
You can delete the data from a “Memory Stick” media with the CLIE Files 
application.

1 Insert “Memory Stick” media on your CLIÉ handheld.

2 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

3 Rotate the Jog Dial™ navigator to select CLIE Files and 
press the Jog Dial™ navigator.
The CLIE Files application starts and the list of data in the “Memory 
Stick” media is displayed. 

Tip
You can also tap the CLIE Files icon to start the application.

4 Tap the data you want to delete and change  to .

5 Tap Del.
The Delete File dialog box is displayed.

6 Tap OK.
The data selected in step 4 is deleted from “Memory Stick” media.

Continued on next page
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To delete all the data at once
Tap Select in step 4 and select Select all.

To cancel the selection
• To cancel all the selections: tap Select and select Clear all.
• To clear only specific items: tap the selected item once again.

To change the folder to be deleted
Tap  or  to select the folder you want to delete. The displays of the folders 
are changed. You can specify a folder to be deleted.

CLIE Files menus
The following describes the menus that are specific to the CLIE Files 
application.

For the menus common to the CLIÉ applications, refer to “Common menus” 
on page 39.

Tool menu

Format Formats (Initializes) a “Memory Stick” media 
inserted in your CLIÉ handheld. Note that all 
data stored in a “Memory Stick” media will be 
erased when formatting the “Memory Stick” 
media.

Media Info Displays information, such as the amount of 
memory or volume label, of your CLIÉ 
handheld or “Memory Stick” media.

New Dir Creates a folder under the current folder in the 
“Memory Stick” media (only when “Memory 
Stick” media is selected).

Rename Changes the name of current directory or 
folder (only when “Memory Stick” media is 
selected).

About CLIE Files Displays the version information of “CLIE 
Files.”
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Exchanging data without using the CLIE Files application
You can exchange the data between a “Memory Stick” media and your CLIÉ 
handheld from the menu of the Application Launcher screen.

However, problems may occur depending on the application. Note the 
following.

• You can copy only applications. Related files cannot be copied.

• Data stored in the “Memory Stick” media (such as image files) cannot be 
displayed.

1 Insert the “Memory Stick” media into the “Memory Stick” slot 
of your CLIÉ handheld.

2 Press and hold the Home /Menu  button on the 
Application Launcher screen.
The menu is displayed.

3 Tap Copy from the CLIE Launcher menu.
The Copy dialog box is displayed.

4 Tap the arrow V next to Copy To, and select Handheld or 
Card. 
From is automatically selected when you select Copy To.

5 Tap the application you want to copy.

6 Tap Copy.
The selected application is copied to CLIÉ handheld or “Memory Stick” 
media.
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Notes on starting applications from a “Memory Stick” media
You can start an application (files with extensions such as .prc,.pdb) from a 
“Memory Stick” media. However, note the following prior to starting them.

• You can start only applications. Related files such as image files or movie 
files may not be opened (played back). 

• When the data that cannot be opened in the application is saved on the 
“Memory Stick” media, move the data to your CLIÉ handheld, or delete it 
by using the CLIE Files application.

Tip
When the data is installed in the “Memory Stick” media with the HotSync® operation, 
the data files are stored in the /PALM/Launcher folder.
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What you can do with beaming
Your CLIÉ handheld is equipped with an IR (infrared) port that enables you to 
exchange data with another Palm OS® PDA device that has an IR port. The IR 
port is located at the top of your CLIÉ handheld, behind the small dark shield.

You can beam the following information between your CLIÉ handheld and 
another Palm OS® PDA device that has an IR port:

• The data of Address Book, Date Book, To Do List, or Memo Pad.

• All data in the category currently displayed in Address Book, To Do List, or 
Memo Pad.

• Address Book data that you designate as your business card.

• Add-on applications installed in the memory.

Note
Some applications are protected from copying and cannot be beamed. Applications 
marked with the   icon cannot be copied.

IR Port

(Location of the IR port may 
vary depending on your model.)
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Beaming information
You can beam the data on your CLIÉ handheld to another Palm OS PDA 
device that has an IR port.

1 Select the data, category, or business card you want to 
beam.

2 Press and hold the Home /Menu  button.
The menu is displayed.

3 Tap one of the following:
• The Beam command for an individual record

• In Address Book only: Beam Business Card

• Beam Category

4 When the Beam dialog box is displayed, point the IR port of 
your CLIÉ handheld directly to the IR port of another Palm 
OS PDA device.

Tip
For best performance of the data exchange, keep 4 to 8 inches (approximately 10 to 
20 centimeters) between your CLIÉ handheld and the other Palm OS PDA device. 
Do not place any obstacle between the devices. The optimum distance for beaming 
may vary depending on devices.

5 Wait for a while until the Beam dialog box shows that the 
transfer is complete.

(Location of the IR port may 
vary depending on your model.)
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Sending applications via beaming

1 Press and hold the Home /Menu  button on the 
Application Launcher screen.
The menu is displayed.

2 Tap Beam from the CLIE Launcher menu.
The Beam screen is displayed.

3 Tap the arrow V next to Beam From and select handheld.
Select handheld when the application you want to send is saved on your 
CLIÉ handheld or  card when it is saved in the “/PALM/Launcher” 
folder on the “Memory Stick” media.

4 Tap an application you want to send on the Beam screen.
Some applications are protected from copying and cannot be beamed.
Applications marked with the  icon cannot be copied.

5 Tap Beam.
The message will be displayed when the beaming is complete.
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Receiving beamed information

1 Turn on your CLIÉ handheld and point the IR port of your 
CLIÉ handheld directly to the IR port of another Palm OS 
PDA device. 
The Beam dialog box is displayed and beaming of data starts.

2 Select the category where you want to save the received 
data. 
You can also create a new category to save the data to, or save it in the 
Unfiled category.

3 Tap Yes.
The data is saved.

Note
When Beam Receive in the Preferences screen is set to Off, you cannot receive data 
using the beaming feature. Prior to beaming data, set Beam Receive to On.

Tips on beaming information
• Data or applications received by beaming are saved in the Unfiled category.

• You can press the Address Book  button for about two seconds to beam 
your business card.

• You can use Graffiti® writing to beam the current entry (  then  , or 
 and then tap ).
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function

What you can do with the Bluetooth™ function
The Bluetooth function enables wireless communication within a range of 
approximately 10 meters. You can use the function to exchange data between 
your CLIÉ handheld and other Bluetooth compliant devices.

Sending data such as image files or Date Book data to another 
CLIÉ handheld with the built-in Bluetooth function or Bluetooth 
Module (optional)

1 Select a file.
1Sending an image file, movie file, voice memo, or 

handwritten memo
Start CLIE Viewer, press and hold the Home /Menu  button to 
display the menu, select Send… from the Data menu, and tap a file 
you want to send.

Continued on next page
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Exchanging data using the Bluetooth™ function

Tip

Sending image files
You can select a method of sending data in the  Send With dialog box.
(The dialog box below may not be displayed depending on your operating 
environment)

2Sending Date Book data or Address Book data
Tap schedule data or address data you want to send, press and hold the 
Home /Menu  button to display the menu, and then select Send 
Event (for Date Book application) or Send Address (for Address 
application) from the menu.

2 Send a file.
After the Bluetooth Discovery dialog box is displayed, the list of 
Bluetooth compatible CLIÉ handhelds within a range of the 
communication area is displayed on the Discovery Results dialog box. 
Tap to select a CLIÉ handheld to which you want to send data.

The Bluetooth Progress dialog box will be displayed on both CLIÉ 
handhelds. Follow the on-screen instructions.

b

Continued on next page
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Exchanging data using the Bluetooth™ function

Tip
If you have renamed a target Bluetooth™ compatible device registered on CLIÉ 
handheld, the device may be listed in the previous name when you detect target 
Bluetooth™ compatible devices.
In this case, follow the procedure below.

1 Press and hold the Home /Menu  button on the Bluetooth 
Preferences screen (page 69). The menu is displayed.

2 Tap Disable device name cache from the Options menu.

3Detect target Bluetooth™ compatible devices.

Note
To view or edit received data/files, applications supporting each data/file must be 
installed in the CLIÉ handheld.

Performing a wireless HotSync® operation with a computer
If you are using a Bluetooth compatible computer, you can perform a wireless 
HotSync® operation between your CLIÉ handheld and computer.
b For details, refer to “Performing a HotSync® operation using the Bluetooth™ 

function” on page 108.
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Connecting to the Internet by communicating 
with the Bluetooth compatible mobile phone

You can enjoy browsing various homepages or sending/receiving e-mail using 
your CLIÉ handheld, via a Bluetooth compatible mobile phone.

Connecting
When you access the Internet via a Bluetooth-compatible mobile phone, you 
need to follow this procedure to bond the device with your CLIÉ handheld.

1 Setting the connection method/Performing bonding

2 Setting up the network connection

Tip

What is “bonding”?
To enable Bluetooth communication between this Bluetooth Module and another 
Bluetooth compatible device, the device must be identified. This process is referred 
to as “bonding,” which is necessary to prevent access from unauthorized Bluetooth 
compatible devices. A common Passkey is used to bond the device to this Bluetooth 
Module.

1 Setting the connection method/Performing bonding
You need to set the communication method and perform bonding for 
Bluetooth communications.

1 Rotate the Jog Dial™ navigator to select the Prefs icon and 
press the Jog Dial™ navigator.
The Preferences screen is displayed.

Tip
You can also tap the Prefs icon to display the Preferences screen.

2 Tap the arrow V in the top right-hand corner of the screen, 
and select Connection.
The list of Available Connections appears.

Continued on next page
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Connecting to the Internet by communicating with the Bluetooth compatible 
mobile phone

3 Tap New.
The Edit Connection screen appears.

1Name: Enter any connection name you like in Custom.

2Connect to: Tap V and select Modem. 

3Via: Tap V and select Bluetooth.

4Dialing: Select the type of telephone circuit you use. The most 
common selection is TouchTone.

5Volume: Select the speaker volume to browse the Internet.

4 Tap Tap to discover.
A Bluetooth compatible device discovery begins in the vicinity of your 
CLIÉ handheld.
When the discovery is complete, the Bluetooth compatible device that has 
been found around your CLIÉ handheld is displayed.

Continued on next page
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Connecting to the Internet by communicating with the Bluetooth compatible 
mobile phone

5 Select the mobile phone you want to bond to your CLIÉ 
handheld, and tap OK.
The Add Trusted Device dialog box appears.

6 Tap Yes.
The Passkey Input screen appears on the display of the mobile phone.

Tip

What is a Passkey?
A Passkey is a secret code entered by the user to enable two Bluetooth compatible 
devices to communicate. When the same alphanumeric string is entered at both 
devices, communication becomes possible. The Passkey may be changed for every 
communication session as long as the same one is used for both devices. Once a 
valid link has been established, communication is possible without further Passkey 
input for a preset period of time.

7 Enter a Passkey on the mobile phone, and click OK.
The Authentication screen appears on your CLIÉ handheld.

8 Enter the same Passkey as Step 6 and tap OK on your CLIÉ 
handheld.
Bonding is completed on the CLIÉ handheld and the mobile phone. The 
communication method you have set is added to the list of Available 
Connections by the name you entered in Name in Step 3.

Continued on next page
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Connecting to the Internet by communicating with the Bluetooth compatible 
mobile phone

Tips
• The step in which the Passkey Input screen appears varies depending on the 

mobile phone, and for some devices, the Passkey input screen does not 
appear. In any case, follow the instructions shown on the screen and enter a 
Passkey when required.

• Depending on the radio wave conditions, it may take time to complete a 
Bluetooth compatible device discovery or establish communication.

• If it takes too long to perform a device discovery, tap Cancel on the discovery 
screen, and conduct a discovery again.

• If the device discovery failed in detecting a device, conduct a discovery again.

Note
Enter a Passkey to activate the security. If the security is off, you may be charged 
the telephone line rental fee that someone else should pay for a dial-up connection 
when you access the Internet from your CLIÉ handheld through a Bluetooth 
compatible mobile phone.

2 Setting up the network connection
For details, refer to “Connecting to the Internet” in the “Read This First 
(Operating Instructions).”

Connecting to the Internet

1 Turn on the power of the mobile phone and activate 
Bluetooth communications.
For detailed operations, refer to the manual of the mobile phone.

2 Start up the appropriate application on the home screen of 
your CLIÉ handheld.

3 Start browsing websites, sending or receiving e-mail.
A dial-up connection is executed.

If you cannot connect to the Internet
Tap the arrow V in the top right-hand corner of the Preferences screen, 
and select Network.
Tap Connect at the bottom of the screen.
If you still cannot connect to the Internet, perform bonding again for the 
Bluetooth compatible device (mobile phone), following the instructions in 
“Connecting” on page 156.

Continued on next page
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Connecting to the Internet by communicating with the Bluetooth compatible 
mobile phone

After using the Internet

1 Stop the dial-up connection on your CLIÉ handheld.
For detailed operations, refer to the “CLIÉ Application Manual” on your 
computer.

2 Terminate Bluetooth communications on the mobile phone.

Tip
Bluetooth communication between the CLIÉ handheld and the mobile phone is 
automatically cut off when the dial-up connection is disconnected.



Using the Calculator 
and finding records

This chapter explains how to efficiently search for records 
and how to use the calculator.
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Using the Calculator (Calc)

Calculating with the Calculator
You can perform basic calculations with the calculator. Moreover, you can 
save the numbers in the calculator memory and recall it from the memory.

1 Rotate the Jog Dial™ navigator to select the Calculator icon 
and press the Jog Dial™ navigator on the Application 
Launcher screen.
The Calculator application starts.

Tip
You can also tap the Calc icon to start the application.

2 Perform calculations.
To use the Calculator, tap the numbers or symbols on the screen with the 
stylus.
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Using the Calculator (Calc)

The functions of the Calculator buttons
The calculator has several buttons to help you perform calculations.

CE Clears the last number you entered. 
Use this button if you make a mistake while entering 
numbers. This button enables you to re-enter the number 
without starting the calculation again.

C Clears the entire calculation and enables you to start a 
new calculation.

+/– Toggles the current number between positive and 
negative. If you want to enter a negative number, enter 
the number and then tap the +/– button.

M+ Adds the current number to the total value in the memory. 
Each number you enter with the M+ button is added to the 
total value stored in the memory. The number to be added 
can be either a calculated value or the number you entered 
by pressing the number buttons. 
Pressing this button has no effect on the current 
calculation (or series of calculations); it merely places the 
value into the memory until it is recalled.

MR Recalls the total value stored in the memory and inserts it 
in the current calculation.

MC Clears any value that is stored in the Calculator memory.

Calculates the square root of the entered number. 
Tap the button after entering the number.
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Using the Calculator (Calc)

Using the Calculator menus

Edit menus

Options menus

Copy, Paste Copies values from Calculator and pastes them into 
another application. You can also paste numeric values 
you copied from another application, such as Memo Pad, 
into Calculator.

Recent Calculations You can review the last series of calculations. This is 
useful when you want to view the calculations later.

About Calculator Shows the version information for the Calculator 
application.
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Finding records

Using the Find option
You can find records, such as Date Book, Address Book, To Do List, or Memo 
Pad data, on your CLIÉ handheld by entering the whole word or first few 
letters. The search results are displayed by application. This feature helps if you 
do not remember which application you used to create the record you are 
searching for.

Note
The Find option is not compatible with some application data.

1 Press and hold the Text Input  /Find  button.
The Find dialog box is displayed.

2 Enter the text you want to find.
You can enter letters, symbols, or numbers.

3 Tap OK.
The Find option starts to search and displays the list of search results.
The attached comments added to each data can also be searched for.

Continued on next page
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Finding records

4 Tap the data you want to view in the list of search results.
The application associated with the data automatically starts to open the 
data.

To stop searching
Tap Stop and Exit.
To resume the search, tap Find More.

Note
The Find option is not case sensitive; searching for “sony” also finds “Sony.”

Tip
Select text in an application prior to pressing and holding the Text Input  /Find  
button to automatically place the text in the Find dialog box.
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Backing up your Sony CLIÉ™ handheld data

You can create backup of your CLIÉ handheld data by one of the following 
methods:

• Back up data to your computer through a HotSync® operation

• Back up data to a “Memory Stick” media using the Memory Stick Backup 
application

Backing up data to your computer with a HotSync® operation
By the default settings, you can back up the following data to your computer 
through a HotSync® operation:

• Memo Pad data files

• Address Book data files

• To Do List data files

• Date Book data files

• Preferences data files

• Application files that have been installed using a HotSync® operation

• User information files to perform a HotSync® operation

When the HotSync® operation is performed, the backup data is compared with 
the data in your computer, and the newer one becomes effective. If you perform 
a hard reset, all data stored in your CLIÉ handheld is erased and the initial 
status will be restored. In this case, you can restore the backup data from your 
computer that was created through the previous HotSync® operation.

Notes
• The following applications or data cannot be backed up with a HotSync® operation.

– Applications or data transferred from a “Memory Stick” media or beamed
– Certain applications or driver files added later, or certain data in an application
For details on applications that cannot be backed up, refer to the manual of each 
application.
When you want to make a complete backup, use the Memory Stick Backup 
application.

• If you customize settings in the Change HotSync Action dialog box, you may not be 
able to create a back up file. You cannot back up an application or restore its data if an 
option other than “Synchronize the files” is selected. For details, refer to “Customizing 
HotSync® application settings (Conduit)” on page 101.
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Backing up your Sony CLIÉ™ handheld data

Backing up data to a “Memory Stick” media using the Memory 
Stick Backup application

With the Memory Stick Backup application, you can back up the following 
applications and data to a “Memory Stick” media.

• Memo Pad data files

• Address Book data files

• To Do List data files

• Date Book data files

• Preferences data files

• Add-on application files

1 Insert a “Memory Stick” media into your CLIÉ handheld.

2 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

3 Rotate the Jog Dial™ navigator to select the MS Backup icon 
and press the Jog Dial™ navigator.
The Memory Stick Backup application starts.

4 Tap the Backup  icon.
The Backup All Files dialog box is displayed.

5 Tap OK.
The Backup Progress screen is displayed.
General information of the back up (date, size, and number of database) is 
displayed in the list.

Notes
• When you create backup data of your CLIÉ handheld in a “Memory Stick” 

media, the size of the backup data may become larger than the size of original 
data. 

• Do not back up when free memory space in your CLIÉ handheld is insufficient. 
The data may not be backed up or restored properly.

Continued on next page
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Backing up your Sony CLIÉ™ handheld data

Tips
• The back-up takes a few minutes.
• In step 4, you can also select an existing file from the backup list then tap Backup 

to overwrite it.
• The data size displayed in the list shows the size of the applications and data 

stored in CLIÉ handheld.
• “Number of database” shows the number of applications and data that have been 

backed up.
• If a backup file in a “Memory Stick” media has been updated using the CLIE 

Files application, the file may not be restored properly.

To delete a backup file from the “Memory Stick” media
 Select the backup data you want to delete in the Backup list, and tap Delete. 

Restoring backup data and applications to your CLIÉ 
handheld

Notes
• When you restore backup data and applications to your CLIÉ handheld, the data 

currently saved in your CLIÉ handheld will be overwritten with the backup data. Any 
data created or edited after you saved the backup will be deleted.

• You can only restore data to the CLIÉ handheld from which you took that backup.

1 Perform a hard reset on your CLIÉ handheld.
b For details on a hard reset, refer to “Basic operations of your Sony CLIÉ™ 

handheld: Restarting your Sony CLIÉ handheld” in the “Read This First 
(Operating Instructions).”

2 Insert the “Memory Stick” media containing the backup files 
into your CLIÉ handheld.

3 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

4 Rotate the Jog Dial™ navigator to select the MS Backup icon 
and press the Jog Dial™ navigator.
The Memory Stick Backup application starts up and the back-up list 
appears.

5 Tap the backup data you want to restore from the list.
Continued on next page
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Backing up your Sony CLIÉ™ handheld data

6 Tap the Restore  icon.
The Restore All Files dialog box is displayed.

7 Tap OK. 
The Confirm Restore dialog box is displayed.

8 Tap OK.
The Restore Process dialog box is displayed.
If there was initial data automatically created by each application when 
you performed a hard reset or if you created or updated data after a hard 
reset, the Overwrite Confirm dialog box is displayed. Tap Yes to 
overwrite, tap Yes to All to overwrite all data, or tap No to leave the data.
When the backup data is restored, the CLIÉ handheld shuts down and 
restarts automatically.

Tip
To select backup data by file, use the Copy feature in the CLIE Files application. 
For details on how to use CLIE Files application, refer to page 136.
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with a password

This chapter explains how to manage your personal details 
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Entering personal information

You can enter personal information such as name, company name and 
telephone number in your CLIÉ handheld. If you assign a password, the 
personal information will be displayed when the CLIÉ handheld is turned on 
next time.

1 Rotate the Jog Dial™ navigator to select the Preferences 
icon and press the Jog Dial™ navigator on the Application 
Launcher screen.
The Preferences screen is displayed.

Tip
You can also tap the Preferences icon to display the Preferences screen.

2 Tap the arrow in the top right-hand corner of the 
Preferences screen and select Owner.
The Owner preferences screen is displayed.

3 Enter your personal information.
When character strings that are entered do not fit within the screen, the 
scroll bar is displayed on the right of the screen.
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Entering personal information

If you have already assigned a password to protect your 
data
As the information is already protected, the personal information cannot be 
entered or edited. Follow the steps below to unlock the protection to enter/edit 
personal information.

1 Rotate the Jog Dial™ navigator to select the Prefs icon and 
press the Jog Dial™ navigator on the Application Launcher 
screen.
The Preferences screen is displayed.

Tip
You can also tap the Prefs icon to display the Preferences screen.

2 Tap the arrow in the top right-hand corner of the 
Preferences screen and select Owner.
The Owner preferences screen is displayed.

3 Tap Unlock.
The Unlock Message screen is displayed.

4 Enter the assigned password and tap OK.
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Locking your CLIÉ handheld with a password 
(Data protection)

You can lock your CLIÉ handheld by assigning a password. Your CLIÉ 
handheld requires a user to enter the password when it is turned on.

Note
To start your CLIÉ handheld when it is locked, you must enter the correct password. If 
you forget the password, you need to perform a hard reset. However, performing a hard 
reset deletes all the data on your CLIÉ handheld (by performing a HotSync® operation, 
you can restore the backup data in your computer).
b For details on how to reset your CLIÉ handheld, refer to “Basic operations of your 

Sony CLIÉ™ handheld: Restarting your Sony CLIÉ handheld” of the “Read This 
First (Operating Instructions).” 

Turning off your CLIÉ handheld after locking
This feature locks and turns off your CLIÉ handheld. To start your CLIÉ 
handheld, you must enter the correct password.

1 Perform a HotSync® operation between your computer and 
CLIÉ handheld to create backup data of your CLIÉ handheld 
in your computer.
For details on the HotSync® feature, refer to “Backing up data to your 
computer with a HotSync® operation” on page 168.

Continued on next page
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Locking your CLIÉ handheld with a password (Data protection)

2 Rotate the Jog Dial™ navigator to select Security and press 
the Jog Dial™ navigator, on the Application Launcher 
screen.
The Security screen is displayed.

Tip
You can also tap the Security icon to display the Security screen.

3 Follow “Assigning a password” on page 178 to assign a 
password.

4 Tap Lock & Turn OFF.
The System Lockout screen is displayed.

5 Tap Off & Lock.
Your CLIÉ handheld turns off and locks.
To start your CLIÉ handheld, you must enter the correct password.

Note
When entering your password after having once turned off your CLIÉ handheld 
before, enter it using the hardware keyboard.
You cannot enter the password using the on-screen keyboard or Graffiti.
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Locking your CLIÉ handheld with a password (Data protection)

Setting your CLIÉ handheld to be locked automatically
You can set a time for your CLIÉ handheld to be locked automatically.

1 Follow steps 1 to 3 of “Turning off your CLIÉ handheld after 
locking” on page 175.
The Security screen is displayed.

2 Tap Never.
The Password screen is displayed.

3 Enter the password and tap OK.
The Lock Handheld screen is displayed.

4 Tap your choice from the list on the Lock Handheld screen.
• Never: Your CLIÉ handheld is not locked automatically.

• On power off: Your CLIÉ handheld is locked when it is turned off.

• At a preset time: Set a time for your CLIÉ handheld to be locked 
automatically.

• After a preset delay: Set a time for your CLIÉ handheld to be locked 
automatically if it is inactive for a preset time.

5 Tap OK.
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Protecting data

You can protect your data from unauthorized users by assigning a password. 

Additionally, you can create private data which will not be shown even if a 
password is entered.

Assigning a password
You can assign a password to protect your private data or to lock your CLIÉ 
handheld.

1 Rotate the Jog Dial™ navigator to select Security and press 
the Jog Dial™ navigator on the Application Launcher screen.
The Security screen is displayed.

Tip
You can also tap the Security icon to display the Security screen.

2 Tap -Unassigned-.
The Password dialog box is displayed.

3 Enter a password.

4 Tap OK.
The Password Confirm dialog box is displayed.

5 Enter the password once again to verify it and tap OK.
Your password is assigned and -Assigned- is displayed in step 2.

Continued on next page
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Protecting data

Tip
In step 3, you can enter a hint to remember your password. The hint will be 
displayed to remind you the correct password when you enter the incorrect 
password.

Changing or deleting a password
You can change or delete the assigned password.

1 Rotate the Jog Dial™ navigator to select Security and press 
the Jog Dial™ navigator on the Application Launcher screen.
The Security screen is displayed.

Tip
You can also tap the Security icon to display the Security screen.

2 Tap -Assigned-.
The Password dialog box is displayed.

3 Enter the current password and tap OK.
The Password dialog box is displayed.

4 Enter a new password and tap OK.
To delete the password, tap Unassign.

If you forget your password
If you forget your password, you can delete it forcibly. However, note that 
deleting the password forcibly also deletes all your private data (if you perform 
a HotSync® operation to synchronize with your computer, you can restore your 
private data that has been backed up).

1 In step 2, tap Lost Password.
The Delete Password dialog box is displayed.

2 Tap Yes.
Your password and private data are deleted.
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Protecting data

Hiding or masking private data
You can choose to hide or mask your private data in applications such as 
Address Book or Memo Pad. To view the private data, you need to enter the 
password. Even if the data is invisible, it is saved.

1 Rotate the Jog Dial™ navigator to select Security on the 
Application Launcher screen.
The Security screen is displayed.

Tip
You can also tap the Security icon to display the Security screen.

2 Tap the arrow V next to Current Privacy to select Mask 
Records or Hide Records. 
The Mask Records screen or Hide Records screen is displayed.

3 Tap OK.
The private data becomes invisible.

When you select Hide Records When you select Mask Records



Enhancing features 
with add-on 
applications

This chapter explains how to enhance features of your CLIÉ 
handheld by installing applications from your computer, 
Internet and “Memory Stick” media.

Enhancing features with add-on 
applications  . . . . . . . . . . . . . . . . . . . . .  182

Installing  . . . . . . . . . . . . . . . . . . . . . . . . . .  183
Installing from your computer . . . . . . . . . . . .  183
Installing applications on a 
“Memory Stick” media. . . . . . . . . . . . . . . . . .  185
Installing from the Internet  . . . . . . . . . . . . . .  185
Deleting the installed add-on applications . . .  186



Enhancing features with add-on applications 182

Enhancing features with add-on applications

You can enhance the features of your CLIÉ handheld by installing applications 
such as games or other software that run on Palm OS (Add-on applications). 
For the latest information on the applications that can be used in your CLIÉ 
handheld, please refer to the official Sony CLIÉ website.

Note
As all the add-on applications installed on your CLIÉ handheld are temporarily saved in 
the memory, all the add-on applications will be deleted when a hard reset is performed. 
In this case, you need to reinstall them on your CLIÉ handheld.

To install the applications from the supplied CD-ROM, refer to “Making full 
use of applications” of the “Read This First (Operating Instructions).”
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Installing

Installing from your computer
You can install the applications of your computer onto your CLIÉ handheld or 
“Memory Stick” media inserted in your CLIÉ handheld.

1 Double click the Palm™ Desktop for CLIÉ icon on your 
Windows desktop.
You can also click Start, Programs (All Programs for Windows XP), 
Sony Handheld, and Palm™ Desktop for CLIÉ software.
The Palm™ Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool screen is displayed.

3 Select the user from the User selector.

4 Click Add.
The Open dialog box is displayed.
The supplied applications are saved in the folder: Program Files/Sony 
Handheld/Add-on/PEG-*** (model name of your CLIÉ handheld).

For details on how to install the applications that are supplied with your 
CLIÉ handheld, refer to “Making full use of applications” of the “Read This 
First (Operating Instructions).”

Continued on next page
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5 Select applications you want to install from the folder and 
click Open.
A list of the selected applications is displayed on the Install Tool screen.
Click Remove to delete applications that you do not want to install. The 
applications will be deleted from the list, but not from your computer.

6 Click Done.
The confirmation screen is displayed.

7 Click OK.

8 Perform a local HotSync® operation. 
Installs the applications selected in step 5 into your CLIÉ handheld or the 
“Memory Stick” media.
b For details on local HotSync®, refer to “Performing a Hotsync® operation” on 

page 61.

Displaying the Install Tool screen directly from the Start 
menu in Windows
To display the Install Tool screen, click Start, Programs (All Programs 
for Windows XP), Sony Handheld, and Installation Tool. You can also 
double-click files that can be installed such as .prc or .pdb format files.
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Installing

Installing applications on a “Memory Stick” media
The applications can be installed on “Memory Stick” media by the following 
methods.

• Install an application directly into “Memory Stick” media from your 
computer using the Memory Stick Import/Memory Stick Export application.

• After step 5 of “Installing from your computer,” click Changing the 
installation destination. Select the application and click either >> or << 
to specify “Memory Stick” media for the location to save the application.

Notes on installing applications on “Memory Stick” media:
In some applications, related files such as image files or movie files cannot be 
opened (played back). 

In the procedure mentioned above, select “Memory Stick” media and install the 
data or application onto the “Memory Stick” media by a HotSync® operation. 
They are installed in /PALM/Launcher folder. Some Sony applications only 
support data in the designated folder. The data installed in /PALM/Launcher 
folder in a “Memory Stick” media by a HotSync® operation cannot be 
displayed in those applications.

In this case, delete those data or applications from the “Memory Stick” media 
with the CLIE Files application.

Installing from the Internet
You can download applications from the CLIÉ website and install them in your 
CLIÉ handheld.

For customers in the U.S.A. and Canada

http://www.sony.com/clie/

For customers in Australia, Hong Kong, Malaysia, Mexico, New Zealand, 
Singapore, Taiwan and Thailand

http://vaio-online.sony.com/clie/

1 Download the applications you want to install in your 
computer, from the Internet.

Continued on next page
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2 Follow the instructions including readme files to install the 
downloaded application in your CLIÉ handheld.
If there are no specific instructions, double-click the downloaded PRC 
format (.prc) file and perform step 6 through 8 of “Installing from your 
computer” on page 183.

Deleting the installed add-on applications

Tip
You can only delete the applications that you installed yourself. Default applications, 
such as Address Book and Memo Pad, cannot be deleted.

1 Press the Home /Menu  button.
The CLIE Launcher screen is displayed.

2 Tap the Delete  icon.
The Delete dialog box is displayed.

Tip
You can also delete an application by dragging an icon and dropping it over the 

Delete  icon on the CLIE Launcher screen when the Use Drag&Drop check 

box on the CLIE Launcher Preferences screen (page 27) is on.

3 Tap the arrow V next to delete source to select Handheld 
or Card.

4 Tap the application you want to delete and tap Delete.
The confirmation message appears.

5 Tap Yes.
The application selected in step 4 is deleted.
To cancel deleting, tap No.

Continued on next page
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6 Tap Done.
The Application Launcher screen is displayed.



Exchanging data with 
another Sony CLIÉ™ 
handheld

This chapter explains how to transfer data from your CLIÉ 
handheld to other CLIÉ handhelds.

Exchanging data with another Sony CLIÉ™ 
handheld  . . . . . . . . . . . . . . . . . . . . . . . .189
Transferring data using the Palm™ Desktop for 
CLIÉ software  . . . . . . . . . . . . . . . . . . . . . . . .  189



Exchanging data with another Sony CLIÉ™ handheld 189

Exchanging data with another Sony CLIÉ™ 
handheld

Notes
• You cannot transfer data from another CLIÉ handheld with the Memory Stick Backup 

application.
• You cannot transfer applications that you installed. You need to reinstall them to your 

CLIÉ handheld.
• Some third-party applications may operate only on your old CLIÉ handheld. For 

details, contact the application manufacturer.

Transferring data using the Palm™ Desktop for CLIÉ software
For data of the basic Palm OS® applications such as Address Book, Memo Pad, 
To Do List, and Date Book, you can use the Palm™ Desktop for CLIÉ software 
to transfer data from your old CLIÉ handheld to the new CLIÉ handheld by 
exporting and importing data.

Before you start transferring data, you need to perform a HotSync® operation 
between your previous CLIÉ handheld and the Palm™ Desktop for CLIÉ 
software for your new CLIÉ handheld using a new user name you have never 
used. After performing a HotSync® operation following “Exchanging and 
updating data using a HotSync® operation” on page 58, follow the steps below.

1 Double-click the Palm™ Desktop for CLIÉ icon on your 
Windows desktop.
You can also click Start, Programs (All Programs for Windows XP), 
Sony Handheld, and Palm™ Desktop for CLIÉ software.
The Palm™ Desktop for CLIÉ software starts.

2 Click the user name of your previous CLIÉ handheld from the 
User name list in the top right-hand corner of the screen.

3 Click the icon of the application you want to copy.

4 Click Export, from the File menu.

5 Enter the file name and click Export.
The data of your old CLIÉ handheld is exported. 
Change the location to save the application if necessary.

Continued on next page
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6 Repeat step 3 through 5 to export data of other applications.

7 Click the user name of your new CLIÉ handheld from the 
User name list in the top right-hand corner of the screen.

Tip
If you have never performed a HotSync® operation with your new CLIÉ handheld, 
select Users from the Tools menu. Click New in the Users screen and enter a 
new user name. 
Then select the user name you just entered.

8 Click Import, from the File menu.

9 Select the files you have exported in step 3 through 6 and 
click Open.

10 Perform a HotSync® operation.
The data exported from your old CLIÉ handheld is copied onto your new 
CLIÉ handheld.

Do not perform a HotSync® operation with the same user 
name in other CLIÉ handhelds
If a HotSync® operation between your new CLIÉ handheld and the Palm™ 
Desktop for CLIÉ software for your old CLIÉ handheld is performed with the 
user name that has been being used, the setting information that is specific to 
the old CLIÉ handheld will be transferred with the data and some problems 
may arise. If you try performing a HotSync® operation in the same way with 
your old CLIÉ handheld, problem may also arise. Do not transfer data by this 
method.

The screen to select the user name is displayed when 
performing a HotSync® operation in your CLIÉ handheld
Please enter a name that is different from the user name of the CLIÉ handheld 
that is being used. If the same user name is used, the Palm™ Desktop for CLIÉ 
software will not recognize your CLIÉ handheld properly and the data of the 
respective models will be mixed or deleted.

Moreover, if you copy UnsavedPreference from another CLIÉ handheld to 
your CLIÉ handheld, you will not be able to manage your CLIÉ handheld with 
another name since the user name is also copied.
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Note on performing a HotSync® operation on another 
CLIÉ handheld
When using another CLIÉ handheld, install (overwrite) the Palm™ Desktop 
for CLIÉ software that is supplied with the newly purchased CLIÉ handheld 
without deleting the Palm™ Desktop for CLIÉ software that is being used, 
from your computer.

The new Palm™ Desktop for CLIÉ software will be installed after uninstalling 
the old software except for the necessary features for another CLIÉ handheld.
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Mexico, New Zealand, Singapore, Taiwan and 

Thailand
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